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Glossaries
There are two glossaries available, one for the terms used in your Agenda, and one for the icons used.

Glossary
Icon Glossary



Glossary
Access Level
Associate
Attachment
Attendance Status
Calendar
Daily Note
Day Event
Default
Designate
Domain
E-mail
Entry
Group Types
Importance level
Local user
Meeting
Node
Off-line
On-line
Organization unit 
Ownership
Propose
Reconciliation
Remote user
Resource
Search parameter
Server
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Task
Tentative
Time Control 
Time slot
Toolbar



Icon Glossary
Your Agenda uses icons to convey as much information as possible without cluttering up the screen. Click
any of the icons shown below to see a brief definition.

When working in your Agenda, pause your mouse over a Toolbar button or Entry to see a brief 
description.

The Toolbars

 

 

The Date Control Bar

The Status Bar

Entry Windows

The Day and Week Views

The Monthly Agenda View

The In-tray

The Notes View



The Task View and Task Display

Special Cursors

The Pop-up Reminders

Importing and Reconciling



Getting Started
For more information on how to get started on your Agenda, click one of the following topic headings:

Netscape Calendar Sign-In
Searching for your User Name
Selecting a Node Alias or ID
Logging in as a Resource
Change Password



Netscape Calendar Sign-In
The Netscape Calendar Sign-In dialog box appears when you open your Calendar. It lets you decide 
whether you want to work in your Agenda on-line or off-line.

To use your Agenda on-line, you must be connected to your server. To be able to use your Agenda off-
line, you must first configure your off-line Agenda (using the off-line Agenda Configuration dialog box 
when opening the off-line Agenda for the first time, or the Off-line Preferences dialog box while on-line).

1. Type your user name (the name by which the system knows you).
You can search for your name by clicking the Search button.

2. Type your password.

3. To work on-line, enter the name of your server. You can either type it yourself or select it from the 
drop-down list box.
To work off-line, choose "Off-line" from the drop-down list box.

Click OK to open your Agenda.

See Also:
Off-Line Preferences — Location
Selecting a Node Alias or ID
Searching for Your User Name

Off-line Agenda Configuration



Searching for Your User Name
If you are unsure of your user name, click the Search button in the Sign-In dialog box to search for it.

You can open another user's or Resource's Agenda (if you can supply the correct password).

Selecting a person
1. Using the People tab of the Directory Search dialog box, type the name of the user you want to sign 

in as and click Search.

2. Choose the name from the Found list box.

· If the user you want is not listed, try using a different search parameter. If you are unsure of the 
spelling, use as few characters as possible to broaden your search.

· Select a name in the Found list box and click Information to find out more about that user.

Click OK to select this user and return to the Netscape Calendar Sign-in dialog box.

Selecting a Resource
1. Using the Resources tab of the Directory search dialog box, type the Resource's name or number 

and click Search.

2. Choose the name from the Found list box.

· If the Resource you want is not listed, try using a different search parameter. If you are unsure of 
the spelling, use as few characters as possible to broaden your search.

· Select a name in the Found list box and click Information to find out more about that Resource.

Click OK to select this Resource and return to the Netscape Calendar Sign-in dialog box

See Also:
Select a Name 



Select a Name
The Select a Name dialog box appears when more than one name matches the characters you entered in
a name edit box.

When you sign in to your Agenda, or when you are adding a name to a list, several names may match the
one you entered (for example, if you type "Smith" you may find there are several Smiths, a Smitham and 
a Smithson with Agendas in your company).

The Select a Name dialog box opens and allows you to select from the list of matching names. Select the 
correct name from the list and click OK.

See Also:
Directory Search — People 
Directory Search — Resources 



Select Node Alias or ID
When you open your Agenda, the Netscape Calendar Sign-in dialog box asks you to sign in. It asks you 
to fill in your name, password and server name.

A server may have several nodes where information is stored. In that case, you need to specify which 
node you wish to connect to from the list in the Select Node Alias or ID dialog box.

Select the correct node and click OK.

See Also:
Netscape Calendar Sign-In 



Logging in as a Resource
You can sign in to the system as a Resource provided that you know the appropriate password. However,
you should not work as the Resource while logged in as that Resource.

When you sign in to the system as a Resource, you can only change the Resource's assigned Access 
Rights and password.

Whenever you need to work as a Resource, you should do so as a Designate. To work as a Resource 
Designate, you must sign in as the Resource, grant yourself the necessary Designate Rights, and then 
access the Resource's Agenda as a Designate from within your own Agenda.

See Also:
Working as a Designate 
Access Rights — Designate
Access Rights — Scheduling
Access Rights — Viewing 
Access Rights — Viewing Tasks 



Change Password
The Change Password dialog box appears when you choose Change Password from the Options menu.

To change your current password, enter it in the upper edit box. Then enter your new password in the 
lower edit box and click OK. This will open the Password Verification dialog box.

If the current password was entered incorrectly, an error message will appear after re-typing the new 
password.

Note: Asterisks appear for each character you enter (rather than displaying the text). The edit boxes are 
case-sensitive.

See Also:
Password Verification



Password Verification
After you change your password, your Agenda asks you to verify the change using the Password 
Verification dialog box.

1. Re-enter your new password.

2. Click OK.

Note: Asterisks appear for each character you enter (rather than displaying the text). The edit boxes are 
case-sensitive.

See Also:
Change Password



Connect to Server
The Connect to Server dialog box is opened when you are in your off-line Agenda and try to connect to 
your on-line Agenda for the first time.

1. Type your user name in the first edit box.
If you do not remember your user name, search for it using the Search button.

2. Type your password in the Password edit box.

3. Type the name and node number of the server you are trying to connect to.
Use the drop-down list box to choose from recently used servers.

Click OK to connect to open your on-line Agenda.



Open Agenda
The Open Agenda dialog box is displayed when you click the Open Agenda button on the Toolbar, press 
Control+O or select Open Agenda, An Agenda from the File menu. Here you choose what Agenda you 
want to open.

To open your own Agenda
Type your user name in the edit box:
· If you cannot remember your user name, click the Search button to search for it in the Directory.

Click OK.

To view the Agenda of another user or Resource
Type the user's name in the edit box:
· If you cannot remember the user's name, click the Search button to search for it in the Directory.

To open a Resource's Agenda, type r:, re:, or res: followed by the Resource's name.

Click OK.

See Also:
All about the Agenda Pages
Working as a Designate



The Group Agenda
The Group Agenda lets you see the Day Views of several people and Resources side by side, allowing 
you to schedule a Meeting at a mutually convenient time.

Open a new Group Agenda using the Selection for Group Agenda dialog box. It appears when you select 
Open Agenda, A Group Agenda from the File menu, press Control+G or click the Group button on the 
Toolbar.

The Group Agenda is made up of a number of columns. The first column, the Combined View, shows at 
what times all the people and Resources you have selected for your Group Agenda are available. All 
subsequent columns show the individual Day Views for each person and Resource included in this Group 
Agenda.

Click the Modify Group Agenda button on the Toolbar to return to the Selection for Group Agenda dialog 
box, where you can modify the people and Resources listed in the Group Agenda.

You can schedule Entries directly into the first column to invite all the users and Resources you have 
chosen. In the New Meeting window that appears, the chosen people and Resources will already be on 
the list. You can modify the list as you would when creating any other Entry, or make changes later using 
the Edit Entry dialog box.

You can also schedule an Entry in a single user's Agenda, in the same way as if you had opened only that
user's Agenda. The Combined View will automatically adjust to accommodate any such Entries that you 
create.

See Also:
Selection for Group Agenda
The Daily Agenda Page
Creating a Meeting — General 
Editing a Meeting — General



Working as a Designate
A Designate is someone who has the right to work in the Agenda of another user in that user's name. 
Designates can only carry out those operations that the owner of the Agenda has granted them the right 
to perform.

In another user's Agenda
To open an Agenda as a Designate, choose Open Agenda, An Agenda As Designate from the File menu 
or press Control+D. Select the user's name from the list box and click OK.When you open the In-tray, 
you'll notice that both your folders and those of the person for whom you are working as a Designate are 
displayed.

As a Designate, you can view, edit and add Entries according to the rights that you have been granted 
(for example, you may or may not also have access to that user's Tasks).

If you create an Entry while working as a Designate, it will be considered to be proposed by the Agenda's 
owner. You will only be able to edit it when working as that user's Designate.

The Designate tab of the Access Rights dialog box (Options menu, Access Rights) lets you give 
Designate Rights to others.

In the Task Display
To open the Task Display of another user as a Designate, select Open Tasks, Modify Other's As 
Designate from the File menu. Select the user's name from the Act as Designate dialog box (if you have 
Designate Rights to mutiple users' Agendas) and click OK. You will then be able to view and modify those
Tasks to which you have been given rights.

Any Tasks you create will be the Tasks of the user in whose name you are working. You will only be able 
to edit them when working as that person's Designate.

As a Resource
Whenever you need to work in a Resource's Agenda, you should do so as a Designate. To be able to do 
this, you must first log on to the system as the Resource and change its Access Rights. Grant yourself the
necessary Designate Rights using the Designate tab of the Access Rights dialog box (Options menu, 
Access Rights).

You can then access the Resource's Agenda as a Designate from within your own Agenda, in the same 
way as you would a person's Agenda (see above).

See Also:
Access Rights — Designate 
Opening the Group Agenda as a Designate 



Opening the Group Agenda as a Designate
Opening a Group Agenda as a Designate lets you create Meetings using the Group Agenda while working
as someone else's Designate.

The Group Agenda gives you a more convenient way of Scheduling an event with several other people, 
instead of viewing all users' Agendas individually.

1. Open the Act as Designate dialog box by choosing Open Agenda, An Agenda as Designate from the 
File menu or by pressing Control+D.

2. Select the person or Resource for whom you wish to work as a Designate and click OK.

3. Select "Open a Group View with:" from the Open Agenda as Designate dialog box to open a new 
Group Agenda.
Once selected, the Add edit box will become active. Add the names of the users and Resources you 
wish to invite in the Add edit box.

Click OK to open this Group Agenda as a Designate.

See Also:
Selection for Group Agenda
The Group Agenda
Working as a Designate 
Access Rights — Designate



Open Tasks
The Open Tasks dialog box appears when you choose Open Tasks, Open Tasks from the File menu, 
press Control+T or click the Open Tasks button on the Toolbar. It lets you select whose Task Display you 
want to view.

To open your own Tasks
Type your user name in the edit box.
· If you cannot remember your user name, click the Search button to search for it in the Directory.

Click OK.

To view another user's Tasks
Type the user's name in the edit box.
· If you cannot remember the user's name, click the Search button to search for it in the Directory.

Click OK.

See Also:
Directory Search — People 
Directory Search — Resources 
Access Rights — Viewing Tasks
The Task Display 



The Task Display
The Task Display contains all of your Tasks: active, incomplete, completed and overdue.

You can open your Task Display in three ways: Choose Open Tasks, Open Tasks from the File menu, 
press Control+T or click the Open Tasks button on the Toolbar.

When you choose Open Tasks from the File menu, you have two options to choose from:

· Open Tasks: This lets you open a Task Display. If you open another user's tasks, you will only be 
able to see the information that user has granted you viewing rights to see on the Viewing Tasks tab 
of the Access Rights dialog box (Options menu, Access Rights). You cannot modify another user's 
Tasks unless working as their Designate.

· Modify Other's as Designate: This lets you open someone else's Task Display and work on that 
user's Tasks as a Designate.You can view, edit and add that user's Tasks according to the Designate 
Rights the user has granted you on the Designate tab of the Access Rights dialog box (Options menu,
Access Rights).

Working in the Task Display
Next to each Task in the Task Display is a small box indicating its status:

The Task is due in the future.
The Task is overdue.
The Task has been completed.

Some Tasks may also have the following symbols:
Indicates that a Reminder has been set for the Task.
Indicates that the Task has Comments.
Indicates that the Task has an attachment.

You can display all or only some Tasks in the Task Display by choosing one of the showing Tasks 
commands from the View menu:

You can create, modify, view and delete Tasks using the commands in the Edit menu, by double-clicking 
on them or by clicking on the Task you want to modify with your right mouse button.

Click a Task's Status box to mark it as 100% Completed. The Completion date will be entered 
automatically.

Sorting Tasks
You can select how to sort your Tasks by choosing one of the sorting commands from the Tasks menu or 
by clicking the column heading of the column you want to sort by.

Duplicating Tasks
Select the Task you wish to duplicate and either choose Duplicate Task from the Edit menu, press 
Control+2 or click your right mouse button and select Duplicate Task from the appearing menu.

Printing Tasks
Choose Print Selected Entry from the File menu or press F11 to print a selected Task.

To print a complete listing of Tasks, click the Print button on the Toolbar, choose Print from the File menu 
or press Control+P.

See Also:



Tasks
The Task View
Creating & Editing Tasks — General
View Task



All about the In-tray
The In-tray is where you receive and manage Entries that you receive from other users. It also contains a 
listing of the Entries you have sent to others.

To open your In-tray, choose Open In-tray from the File menu, press Control+I or click the Open In-tray 
button on the Toolbar.

When you open your In-tray, you will see a folder labeled with your name (if you have opened other 
Agendas as a Designate, folders will also appear labeled with their names). When this folder is open, it 
displays four folders labeled New Entries, Entries you've accepted, Entries you've sent out and Entries 
you've refused. You open and close folders by clicking them. 

When open, a listing of the folder's contents will appear below the folder. Each Entry in the list will be 
preceded by an icon, identifying the Entry as a Daily Note, a Holiday, a Meeting, a Day Event or a 
repeating Entry. They will look like this:

Daily Note
Holiday
Meeting
Day Event
Recurring Entry.

To see more information about an Entry:

· Click its icon to see the list of invited users and Resources.
· Double click an Entry's title (or on your name in the list of invited users) to view and edit the Entry 

(you can only edit Entries you proposed). This also allows you to change your reply.
· Click anywhere on its topic line with your right-mouse button and choose View Entry from the menu 

that appears.

You can also move an Entry directly from one folder to another by clicking and dragging it into another 
folder. Your Agenda will make the necessary changes for you (for example, changing your reply to the 
Entry). To select and move multiple Entries at once, use the Shift and Control keys.

See Also:
New Entries
Entries you've Accepted
Entries you've Sent Out
Entries you've Refused



Directory Search — People
The Directory Search dialog box appears whenever you click the Search button. It also appears when you
choose Search Directory from the Edit menu. The People tab allows you to look for people in the 
Directory.

The Directory Search dialog box looks and performs differently depending on where you opened it from. 
There are three different versions of the Search Directory dialog box:

· Single user selection: This version of the Directory Search dialog box opens when you click the 
Search button in a dialog box where you can only select one person or Resource (for example, when 
you search for a name in the Open Agenda dialog box).

· Multiple user selection: This version opens when you click the Search button in a dialog box where 
you can select several people or Resources (for example, when adding people to a new Meeting or 
Appointment).

· User Information: This version opens when you choose Search Directory from the Edit menu or 
press F12. In this case, you can only learn more about the people and Resources on your system.

See Also:
Directory Search — Single User Selection 
Directory Search — Multiple User Selection 
Directory Search — User Information 
Directory Search — Resources
Directory Search — Groups
Selecting Several Users



Directory Search — Single User Selection
The People tab of the Directory Search dialog box allows you to search and select one user (for example,
in the Calendar Sign-in dialog box or the Open Agenda dialog box).

To search for a person, use the People tab and follow the steps below

1. Type the name of the person you want to find.
You can also search the Directory using one or more search parameters.

2. Click Search. The result of your search will then be listed in the Found list box.

· Users with an (R) or other notes in brackets next to their name are Remote users.
· To print the result of your search, click Print.
· Select a person's name and click Information to find out more about them.
· If your Agenda finds more than 100 people, only 100 names at a time will be listed. Use the 

double arrow buttons next to the Search button to toggle back and forth between lists.

To select a user, select the user's name in the Found list box and click OK.

See Also:
Directory Search — Single Resource Selection



Directory Search — Multiple User Selection
This tab of the Directory Search dialog box allows you to search and select several users (for example, on
the General tab of the New Meeting window).

To search for one or several users, use the People tab and follow the steps below:

1. Type in a name and/or other search parameters.

2. Click Search. The result of your search will then be listed in the Found list box.

· Users with an (R) or other notes in brackets next to their name are Remote users.
· To print the result of your search, click Print.
· Select a person's name and click Information to find out more about them.
· If your Agenda finds more than 100 people, only 100 names at a time will be listed. Use the 

double arrow buttons next to the Search button to toggle back and forth between lists.

3. To select users, select their names in the Found list box and click Add. They will appear in the 
Selected list box to the right.

· To select all listed names, click Add all.
· To delete a name you have added, select it in the Selected list box and click Remove.
· To print the list of people and Resources that you have selected, click Print.

4. When you have finished selecting people, go to the other tabs to select Resources and groups. The 
people selected on this tab will remain listed in the Selected list box, unless you remove them.

Click OK once all the people and Resources that you want are listed in the Selected list box. They will 
automatically be included in the list of people/Resources that you were working on when you opened the 
Search dialog box.

See Also:
Directory Search — Multiple Resource Selection 
Directory Search — Multiple User Selection by Group 



Directory Search — User Information
This version of the Directory Search dialog box is opened when you select Search Directory from the Edit 
menu or press F12.

In this version you cannot select a person's name for use in a list or an edit box. It simply gives you quick 
access to the System Directory, so that you can learn more about the people, Resources and groups on 
your system.

To search for a person, use the People tab and follow the steps below.

1. Type the name of the person you want to find.
You can also search using one or more search parameters.

2. Click Search. The result of your search will then be listed in the Found list box.

· Users with an (R) or other notes in brackets next to their name are Remote users.
· To print the result of your search, click Print.
· If your Agenda finds more than 100 people, only 100 names at a time will be listed. Use the 

double arrow buttons next to the Search button to toggle back and forth between lists.

3. Select a user's name and click Information to see that person's information.

Click Done when finished with your Directory search.

See Also:
Directory Search — Resources
Directory Search — Directory Search by Group 



Directory Search — Resources
The Directory Search dialog box appears whenever you click the Search button. It also appears when you
select Search Directory from the Edit menu or press F12. The Resources tab allows you to look for 
Resources in the Directory.

The dialog box looks and performs differently depending on where you opened it from. There are three 
different versions of the Directory Search dialog box:

· Single Resource Selection: This version of the Search dialog box opens when you click the Search 
button in a dialog box where you can only select one person or Resource (for example, when you 
search for a name in the Open Agenda dialog box).

· Multiple Resource Selection: This version opens when you click the Search button in a dialog box 
where you can select several people or Resources (for example, when using a people/Resources tab,
found in many dialog boxes).

· Resource Information: This version opens when you choose Search Directory from the Edit menu or
press F12. In this case, you can only learn more about the people and Resources on your system.

See Also:
Directory Search — Single Resource Selection 
Directory Search — Multiple Resource Selection 
Directory Search — Resource Information 
Directory Search — People 
Directory Search — Groups
Selecting Several Users



Directory Search — Single Resource Selection
The Resources tab of the Directory Search dialog box allows you to search and select one Resource (for 
example, in the Calendar Sign-in dialog box or the Open Agenda dialog box).

To search for a Resource, use the Resources tab of the dialog box and follow the steps below.

1. Type the Resource's name or number as the search parameter.

2. Select "Local Resources only" if you do not want to display Remote Resources.

3. Click Search. The result of your search will then be listed in the Found list box.

· Resources with an (R) or other notes in brackets next to their names are Remote Resources.
· To print the result of your search, click Print.
· Select a Resource's name and click Information to find out more about it.

To select a Resource, select its name in the Found list box and click OK.

See Also:
Directory Search — Single User Selection 



Directory Search — Multiple Resource Selection
This tab of the Directory Search dialog box allows you to search and select several Resources (for 
example, when selecting Resources to add to a new Meeting or Appointment).

To search for one or several Resources, use the Resources tab of the dialog box and follow the steps 
below.

1. Type a Resource's name or number as the search parameter.

2. Select "Local Resources only" if you do not want to display Remote Resources.

3. Click Search. The result of your search will then be listed in the Found list box.

· Resources with an (R) or other notes in brackets next to their names are Remote Resources.
· To print the result of your search, click Print.
· Select a Resource's name and click Information to find out more about it.

4. To select Resources, select their names in the Found list box and click Add. The selected names will 
then appear in the Selected list box to the right.

· To select all listed names, click Add all.
· To remove names that you have added, select them and click Remove.
· To print a list of the people and Resources that you have selected so far, click Print.

5. When finished with the Resources tab, go on to the People and Groups tabs. The selected Resources
will remain listed in the Selected list box, unless you remove them.

Click OK once all the people and Resources that you want to select are in the Selected list box. They will 
automatically be included in the list of people/Resources that you were working on when you opened the 
Directory Search dialog box.

See Also:
Directory Search — Multiple User Selection 
Directory Search — Multiple User Selection by Group 



Directory Search — Resource Information
This version of the Directory Search dialog box is opened when you select Directory Search from the Edit 
menu or press F12.

In this version you cannot select a Resource's name for use in a list or an edit box. It simply gives you 
quick access to the System Directory, so that you can learn more about the people, Resources and 
groups on your system.

To search for a Resource, use the Resources tab and follow the steps below.

1. Type the Resource's name or number as the search parameter.

2. Select "Local Resources only" if you do not want to display Remote Resources.

3. Click Search. The result of your search will then be listed in the Found list box.

· Resources with an (R) or other notes in brackets next to their names are Remote Resources.
· To print the result of your search, click Print.

4. Select a Resource's name and click Information to find out more about it.

Click Done when you have finished with your Directory Search.

See Also:
Directory Search — Multiple User Selection 
Directory Search — Multiple User Selection by Group 
Directory Search — People
Directory Search — Groups
Selecting Several Users



Directory Search — Groups
The Directory Search dialog box appears whenever you click the Search button. It also appears when you
choose Search Directory from the Edit menu or press F12. The Groups tab allows you to look for groups 
within the Directory.

The Directory Search dialog box looks and performs differently depending on where you opened it from. 
There are two different versions of the Search dialog box:

· Multiple User Selection: This version opens when you click the Search button in a dialog box where 
you can select several people or Resources (for example, when using a people/Resources tab, found 
in many dialog boxes).

· User Information: This version opens when you choose Search Directory from the Edit menu or 
press F12. In this case, you can only learn more about the people and Resources on your system.

See Also:
Directory Search — Multiple User Selection by Group 
Directory Search — User Information by Group 
Directory Search — People 
Directory Search — Resources 
Selecting Several Users



Directory Search — Multiple User Selection by Group
The Group tab of the Directory Search dialog box allows you to search and select several members of a 
group (for example, when selecting people and Resources to add to a new Meeting or Appointment).

To search and select one or several members of a group, use the Groups tab and follow the steps below:

1. Choose the Group types you want displayed by selecting the appropriate checkboxes.

2. Select a group by clicking it in the groups available list box. Its members are displayed in the 
Members list box. The selected group's name and owner will appear to the right of the box.

· Users with an (R) or other notes in brackets next to their name are Remote users.
· Select a group member's name in the list box and click Information to find out more.

3. To select group members, select their names in the Found list box and click Add. The selected 
names will then appear in the Selected list box to the right.

· To select the whole group, click Add all.
· To remove names that you have added, select them and click Remove.
· To print a list of the people and Resources you have selected, click Print.

4. When finished with the Groups tab, go on to the People and Resources tabs. The selected group 
members will remain listed in the Selected list box, unless you remove them.

Click OK once all the people and Resources that you want to select are listed in the Selected list box. 
They will automatically be included on the list of people/Resources that you were working on when you 
opened the Directory Search dialog box.

See Also:
Directory Search — Multiple User Selection 
Directory Search — Multiple Resource Selection 



Directory Search — User Information by Group
This version of the Directory Search dialog box is opened when you select Directory Search from the Edit 
menu or press F12.

In this version you cannot select a group member's name for use in a list or an edit box. It simply gives 
you quick access to the System Directory, so that you can learn more about the people, Resources and 
groups on your system.

To search for group members, use the Groups tab and follow the steps below.

1. Choose the Group types you want displayed by selecting the appropriate checkboxes.

2. Select a group by clicking it in the groups available list box. Its members are displayed in the 
Members list box. The selected group's name and owner will appear to the right of the box.

· Users with an (R) or other notes in brackets next to their name are Remote users.
· To print a list of the selected group's members, click Print.

3. Select a group member's name in the list box and click Information to find out more.

Click Done when finished with your Directory search.

See Also:
Directory Search — User Information 
Directory Search — Resource Information 
Directory Search — People
Directory Search — Resources
Selecting Several Users



Selecting Several Users
You have three search options in the Directory Search Dialog box for selecting user names. You can 
select user names from a list of people, Resources or groups.

Selecting from a list of people
1. Type the name of the person you want to find.

You can also search the Directory using any other search parameter.

2. Click Search. The result of your search will then be listed in the Found list box.

3. Select users. Select one or several user names in the Found list box and click Add to select them.
· Users with an (R) or other notes in brackets next to their name are Remote users.
· To select all listed names, click Add all.
· To remove names that you have added, select them in the Selected list box and click Remove.

Click OK when all the names you want have been added.

Selecting from a list of Resources
1. Type the name or number of the Resource you want to find.

You can also search the Directory using any other search parameter.

2. Select "Local resources only" if you do not want to display Remote Resources.

3. Click Search. The result of your search will then listed in the Found list box.

4. Select Resources. Select one or several Resource names in the Found list box, and click Add to 
select them.

· Resources with an (R) or other notes in brackets next to their names are Remote Resources.
· If you want to select all listed names, click Add all.
· To remove names that you have added, select them in the Selected list box and click Remove.

Selecting from a group
1. Select the Group types you want to display.

2. Click Search. The result of your search will then be listed in the groups available list box.

3. Select a group.

4. Select group members. Select one or several names in the Members list box, and click Add to select 
them.

· Users with an (R) or other notes in brackets next to their name are Remote users.
· To select all listed names, click Add all.
· To remove names that you have added, select them in the Selected list box and click Remove.

Click OK when all the names you want have been added.

See Also:
Searching — Groups
Searching — People
Searching — Resources



Upload From Local File
This allows you to update your host Agenda with the information in your Off-line Agenda.

You can upload your off-line Agenda to your host Agenda by choosing Upload From Local File from the 
File menu.

If you want to start the uploading of your off-line Agenda, click Yes. Otherwise, click No.

Once the upload starts you can follow the process in the Uploading off-line Agenda dialog box. To cancel 
the uploading, click Cancel.

See Also:

Host Reconciliation



Download To Local File
This allows you to update your Off-line Agenda with the information in your host Agenda.

You can download your host Agenda to your off-line Agenda by choosing Download To Local File from the
File menu.

If you want to start the downloading of your on-line Agenda, click Yes. Otherwise, click No.

Once the download starts you can follow the process in the Downloading Host Agenda dialog box. To 
cancel the downloading, click Cancel.

See Also:

Host Reconciliation



The Off-line Agenda
You can use your Agenda both on-line and off-line. This means you can work on your Agenda even when 
you're not connected to the server. You can easily update your on-line Agenda by uploading your off-line 
file: your Agenda will help you reconcile any differences between the two quickly and easily.

For more information on using the on-line and off-line features of your Agenda, click one of the following 
topic headings:

Signing In 
Off-line Agenda Configuration
Host Agenda Download 
Local File Upload 
Host Reconciliation
Off-line Reconciliation Preferences
Off-line Preferences — Location
Off-line Preferences — Download Preferences
Off-line Preferences — People/Resources
Off-line Preferences — Groups



Export Utility
The Export Utility dialog box (File menu, Export Data) allows you to export information from Agendas into 
text files or supported palmtops.

Select from what type of file or palmtop you will be exporting your data. Depending on your choice, 
Agenda data and/or Address Book data can be exported. The type of data that each choice can export is 
listed when selected in the list box.

Click Continue to open the next dialog box and enter your export settings. Click Cancel to abort.

See Also:
Export Utility — Agenda 
All about your Agenda's Palmtop Support
Serial Settings
Import Utility
Initial Set-up Procedure for Exporting to the Palmtop
Installing the UniLink Server on your HP Palmtop
Working with vCalendar Objects
Palmtop Reconciliation



Export Utility — Agenda
The Export Utility (File menu, Export Data) allows you to export information from Agendas into text files or
supported palmtops.

The title of this dialog box is the name of the file or palmtop type you chose in the Export Utility dialog 
box.

1. Select the data you want to export.

· Select the "Events" checkbox to export all Meetings, Day Events, Daily Notes and Holidays.
· Select the "Tasks" checkbox to export Tasks.

2. Set the period for which you wish to export data.

· To set a range of dates, select "Range" and enter the Start and End dates.
· To export all the Entries contained in your Agenda, select "All".
· To customize a time period, select "Custom" and set the time period in the boxes below. Your 

customized time period will be saved until the next time you export data.

3. Select the Agendas from which you wish to export data.

· Click the Checkmark button to add a name in the edit box.
· To search for a name in the Directory, click the Search button.
· To delete a name, select it and click Delete.
· Click the Group button to add members from a group.

4. If you are exporting your data to a palmtop, select the serial port you are using. Click Link Settings 
next to the File Name edit box and select one of the options offered in the Serial Settings dialog box.
If you are exporting data to your palmtop and you have not done an export/import with your palmtop 
yet, you need to install a link between your Agenda and the palmtop. Open the DataComm application
on your palmtop, choose File Receive from the File menu and enter the file name ul.exe. Then click 
Link Settings in the Export Utility dialog box in your Agenda, and click Link Install in the Serial 
Settings dialog box that is called up. You will not need to do this again, unless the batteries on your 
palmtop run down, erasing all the data and applications it contains.

5. File names will automatically be assigned to files being created when you export. If you select the 
name of a person or a Resource in the list box, the corresponding file name is displayed in the edit 
box below. You can change the names of these files if you wish to. If you are not exporting to a 
palmtop, you can look for the file on your system by clicking Browse.

6. Click OK only when finished with all tabs in the dialog box.
If you are exporting data to a palmtop and inconsistencies exist between the palmtop and your 
Agenda, you may have to go through the Palmtop Reconciliation process before the conclusion of 
your data export. If so, the Palmtop Reconciliation dialog box will be called up.

See Also:
Export Utility 
All about your Agenda's Palmtop Support
Serial Settings
Import Utility
Initial Set-up Procedure for Exporting to the Palmtop
Installing the UniLink Server on your HP Palmtop
Working with vCalendar Objects
Palmtop Reconciliation



Import Utility
The Import Utility (File menu, Import Data) allows you to import data into your Agenda from certain files 
and supported palmtops.

Select to what type of file or palmtop you will be importing your data. Depending on your choice, Agenda 
data and/or Address Book data can be imported. The type of data that each choice can export is listed 
when selected in the list box.

Click Continue to open the next dialog box and enter your import settings. Click Cancel to abort.

See Also:
Import Utility — Agenda 
Export Utility
Serial Settings
vCalendar Entries Found
Palmtop Reconciliation



Import Utility—Agenda
The Import Utility (File menu, Import Data) allows you to import data into your Agenda from certain files 
and supported palmtops.

The title of this dialog box is the name of the file or palmtop type you chose in the Import Utility dialog box.

1. Select the data you want to import.

· Select the "Events" checkbox to import all Meetings, Day Events, Daily Notes, and Holidays.
· Select the "Tasks" checkbox to import Tasks.

2. Set the period for which you wish to import data.

· To set a range of dates, select "Range" and enter the Start and End dates.
· To export all the Entries contained in your Agenda, select "All".
· To customize a time period, select "Custom" and set the time period in the boxes below. This time

period will be saved until the next time you export data.

3. If you are importing data from a palmtop, select the serial port you are using. Click Link Settings next
to the File Name edit box and select one of the options offered in the Serial Settings dialog box.
If you are importing data from your palmtop and you have not done an export/import with your 
palmtop yet, you need to install a link between your Agenda and the palmtop. Open the DataComm 
application on your palmtop, choose File Receive from the File menu and enter the file name ul.exe. 
Then click Link Settings in the Import Utility dialog box in your Agenda, and click Link Install in the 
Serial Settings dialog box that is called up. You will not need to do this again unless the batteries on 
your palmtop run down, erasing all the data and applications it contains.

4. Enter the name of the file from which you will be importing data in the File Name edit box. If you are 
not importing from a palmtop, you can look for the file by clicking Browse.

5. Click OK when finished entering the information.

· If you are importing a vCalendar file, a dialog box will appear. It lets you handle the Entries being 
imported either individually or collectively.

· When importing from a palmtop, the Palmtop Reconciliation dialog box will open to let you deal 
with inconsistencies between the palmtop and your Agenda.

See Also:
Import Utility
Export Utility
Serial Settings
Palmtop Reconciliation



Printing — Agenda Pages
The Print dialog box lets you choose a print layout, the range of dates to print and which types of Agenda 
pages you want printed. You can open it in three ways: Choose Print from the File menu, press Control+P
or click the Print button on the Toolbar.

Your Agenda will print the Agenda you have selected (for example, if you have yours and other users' 
Agendas opened at the same time, the Agenda that is active will be printed).

1. To change your printer setup, click Setup to open the Print Setup dialog box.

2. Select the layout you want to use from the Layout drop-down list box. Click Options to customize this
layout using the Layout Options dialog box. 

3. Choose the range of dates you want to print. Type the dates directly into the Date boxes, use the 
arrows or click the Calendar button.

4. Choose which types of Agenda pages you want to print by selecting the appropriate checkboxes at 
the bottom of the dialog box.

5. To preview your print-out before printing, click Preview.

Click OK to print your Agenda.

See Also:
Printing
Print Preview 



Printing — In-Tray, Task Display and Selected Entries
This version of the Print dialog box opens when you print the In-tray, Task Display or a selected Entry. You
can open it in three ways: Choose Print from the File menu, press Control+P or click the Print button on 
the Toolbar.

1. Click Setup to change your printer setup using the Print Setup dialog box.

2. Select the layout you want to use from the Layout drop-down list box. Click Options to customize this
layout using the Layout Options dialog box. 

3. Click Preview to view your print-out before printing.

Click OK to print.

See Also:
Printing
Print Preview



Print Preview
You can preview the print-outs of your Agenda pages by clicking Preview in the Print dialog box.

1. To scroll through a multiple-page print-out, use the Next Page and Previous Page buttons.

2. If you prefer to view two pages at a time, click the Two Pages button. Click the One Page button to 
return to the one-page-per-screen view.

3. You can zoom in on documents in two ways:

· Click the area you wish to magnify with the magnifying cursor.
· Click the Zoom In button on the Toolbar.
The view will expand to let you see the print-out in more detail. You can zoom in twice. If you have 
reached maximum magnification, the cursor will revert to the normal pointer.

4. To zoom out, click the Zoom Out button on the Toolbar.

Click Close to return to the Print dialog box.

See Also:
Printing — Agenda Pages 
Printing 



Saving your Print Layouts
When you have customized a particular layout format (such as the Franklin Day Planner Classic, the Day-
Timer Junior Pocket, or any of the many other formats your Agenda allows you to print), you may want to 
save your set-up. This way you can use the exact same settings the next time you print out your Agenda 
pages.

1. To save the layout you have created or modified, click Save as to open the Save As dialog box.

2. Type a name for the layout you have created. This name will appear in the list of layouts offered in the
Print dialog box.

Click OK to return to the Layout Options dialog box.

See Also:
The Print Dialog Box 
Print Preview 



Layout Options — Daily
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Daily tab allows you to select the layout for your Daily Agenda pages.

1. Select the special features you would like printed on your Daily Agenda pages. You can choose one 
or more of the following:

· Start time: Prints the times at which Meetings are scheduled to begin.
· End time: Prints the times at which Meetings are scheduled to end.
· Description: Prints any Descriptions included in Meetings.
· Location: Prints the scheduled location for Meetings.
· Gray shading: Shades all your Meetings gray, making available time more visible.
· Overflow pages: Prints an overflow page for items that do not fit on the Daily Agenda page.

2. Select the column headings using the drop-down list box. This allows you to modify the layout of the 
printed Daily page. You can choose where its different parts will be found and what will be included in 
the print-out.

3. Set the time range you want printed for your Daily Agenda pages.
Use the arrows to the right of the time display boxes or click the Clock button to set the time.

4. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by clicking Save. Your Agenda can save a maximum of 100 customized layouts.

5. To change the name of the layout you are working on, click Rename. A dialog box will appear, asking 
you to enter a new name for the layout.

6. Click Reset to return your settings to the Default settings for the "Portrait" layout.

7. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Weekly
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Weekly tab allows you to select the layout for your Weekly Agenda pages.

1. Select the special features you would like printed on your Weekly Agenda pages. You can choose one
or more of the following:

· Start time: Prints the times at which Meetings are scheduled to begin.
· End time: Prints the times at which Meetings are scheduled to end.
· Description: Prints any Descriptions included in Meetings.
· Location: Prints the scheduled location for Meetings.
· Work days only: Will not print Saturdays and Sundays.
· Gray shading: Shades all Meetings gray, making available time more visible.
· Overflow pages: Prints an overflow page for items that do not fit on the Weekly Agenda page.
· Day Events and Notes: Prints your Day Events, Daily Notes, and Holidays at the bottom of each 

day.

2. Set the time range you want printed for your Weekly Agenda pages.

3. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by clicking Save. Your Agenda can save a maximum of 100 customized layouts.

4. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

5. Click Reset to return your settings to the Default settings for the "Portrait" layout.

6. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Multiweek
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Weekly tab allows you to select the layout for your Weekly Agenda pages.

1. Enter the amount of weeks you want printed on each page in the edit box. You can print from one to 
five weeks per page.

2. Select the special features you would like printed on your Multiweek Agenda pages. You can choose 
any and all of the following:

· Overflow pages: Prints an overflow page for items that do not fit on the Weekly Agenda page.
· Work days only: Will not print Saturdays and Sundays.
· Start time: Prints the times at which Meetings are scheduled to begin.
· End time: Prints the times at which Meetings are scheduled to end.

2. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by clicking Save. Your Agenda can save a maximum of 100 customized layouts.

3. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

4. Click Reset to return your settings to the Default settings for the "Portrait" layout.

5. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Monthly
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Monthly tab allows you to select the layout for your Monthly Agenda pages.

1. Select the special features you would like printed on your Monthly Agenda pages. You can choose 
one or more of the following:

· Overflow pages: Prints an overflow page for items that do not fit on the Monthly Agenda page.
· Work days only: Will not print Saturdays and Sundays.
· Start time: Prints the times at which Meetings are scheduled to begin.
· End time: Prints the times at which Meetings are scheduled to end.

2. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by simply clicking Save. Your Agenda can save a maximum of 100 customized 
layouts.

3. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

4. Click Reset to return your settings to the Default settings for the "Portrait" layout.

5. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Day List
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Day List tab allows you to select the layout for your Day List pages.

1. Choose which options you want included on your Day List print-outs.

· Attendees: Prints the names of Meeting attendees. The maximum value allows you to limit the 
number of participants the print-out will list. If there are more participants than the set limit, your 
print-out will only indicate the number of attendees.

· Description, Task Comments: Prints Meeting Descriptions and Task Comments. The maximum 
value allows you to limit the length of Descriptions or Comments that your Agenda will print. If the 
Description or Comment exceeds the set limit, your print-out will only indicate its length.

· Day Events, Notes, Holidays and Upcoming Reminders: Prints all Entries that are displayed in
the Notes View of your Daily Agenda page on your Day List.

· Tasks: Prints all Tasks for the selected days.
· Meeting Owner: Prints the name of the person who owns the Meeting.
· Importance level: Prints Meeting Importance levels and Task Priorities.
· End Time: Prints the ending time for your Meetings.
· Print Empty days: Days not containing any Entries will be included on your Day List.
· Boxes: Places all Meeting information inside a box.
· Title on a separate line: Prints an Entry's title on a line all by itself.
· Keep formatting of Details: Maintains the line structure of the original Details you assigned this 

Entry.

2. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by clicking Save. Your Agenda can save a maximum of 100 customized layouts.

3. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

4. Click Reset to return your settings to the Default settings for the "Portrait" layout.

5. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Task List
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Task List tab allows you to select the layout for printing your Tasks.

1. Select the special features you would like printed on your Task List pages. You can choose one or 
more of the following:

· Task Comments: Prints any Comments you have included in your Tasks. The maximum value 
allows you to limit the length of Comments that your Agenda will print. If the Description or 
Comment exceeds the set limit, your print-out will only indicate its length.

· Start date: Prints the dates on which your Tasks are scheduled to start.
· Due Date: Prints the dates on which your Tasks are due.
· Completion date: Prints the dates on which your completed Tasks were completed.

2. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by clicking Save. Your Agenda can save a maximum of 100 customized layouts.

3. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

4. Click Reset to return your settings to the Default settings for the "Portrait" layout.

5. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Fonts
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Fonts tab allows you select the fonts that will be used when printing your Agenda page or Address 
Book. The fonts that appear are the Default selections.

1. Choose the Header and Text fonts using their respective drop-down list boxes. When you choose the 
Default font, the computer will select the type face that most closely matches either Helvetica or 
Times.

2. Choose the Header and Text font sizes using their respective drop-down list boxes. You can select 
either normal, smaller or larger. Your Agenda will use the appropriate size of the selected font for the 
layout you are using.

3. Choose Save to save your customized format under its original name.
Choose Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by clicking Save. Your Agenda can save a maximum of 100 customized layouts.

4. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

5. Click Reset to return to the Default settings.

6. Click Delete to permanently erase the layout you have been working on.

Click OK to return to the Print dialog box.



Layout Options — Margins
Click Options in the Print dialog box (File menu, Print) to set up your layout options using the Layout 
Options dialog box.

The Margins tab allows you to select the margins that will be used when printing your Agenda page or 
Address Book. The values that appear are the Default settings.

1. Select the measuring unit using the "Unit" drop-down list box.

2. Set the number of rows and columns you wish to have by typing the number in the corresponding 
box.

3. Set the margins and internal margins by typing the appropriate values in each box.

4. Click Save to save your customized format under its original name.
Click Save as to save your customized format under a new name. Once named, you can save all 
subsequent changes by simply clicking Save. Your Agenda can save a maximum of 100 customized 
layouts.

5. To change the name of the layout you are working on, click Rename. A dialog box will appear asking 
you to enter a new name for the layout.

6. Click Reset to return your settings to the Default settings for the "Portrait" layout.

7. Click Delete to permanently erase the layout you have been working on

Click OK to return to the Print dialog box.



Locate Person
The Locate Person feature (Options menu, Locate Person) allows you to find out what people, Resources
or groups have scheduled at a specific time.

1. Type the name of the user you wish to locate in the Add edit box.

· If you want to find a Resource, type r:, re:, or res: followed by its name.
· Click the Search button to look through the directory.
· If you want to find a group, type g:, gr:, or grp: followed by its name.
· Click the Checkmark button to accept the name. Your Agenda will search for this user.

2. Enter the date on which you want to locate the user. You can enter it directly using the Date box, the 
arrows or by clicking the Calendar button.

3. Set the time at which you want to locate the user by entering it directly in the Time box, using the 
arrows or clicking the Clock button

4. Your Agenda will search for the user using these search parameters and display the information it 
finds in the list box.
The answer you get from your search depends on what viewing rights the user has granted you for 
the type of Meeting that is scheduled at the time selected. Users set viewing rights for Entries of each 
Access level.

· If you have the right to see all information in the Meeting, you will see both the Entry's Title and its
location.

· If you only have the right to see the Agenda owner's busy times, you will just be told that the user 
is busy at that time.

· If you do not have any viewing rights for a Meeting, you will not even be made aware of its 
existence.

If your Agenda does not find any information fitting your search parameters, it will indicate this in the 
list box.

Click Done when finished locating users and resources.

See Also:
Access Rights — Viewing 



Manage Groups
The Manage Groups dialog box (Options menu, Manage Groups) allows you to add and modify groups of 
users. You can only modify groups while working on-line.

Click New to create a new group using the Group Properties dialog box.

Click Edit to modify a selected group using the Group Properties dialog box.

Click Delete to erase a selected group from this dialog box. Click Yes to confirm the deletion or No to 
cancel.

See Also:

Group Properties 



Group Properties
The Group Properties dialog box allows you to create and modify groups.

1. Type the name of the group in the Group Name edit box.

2. Choose the group type using the drop-down list box.

3. Add users and Resources using the Members edit box.

· Click the Checkmark button to accept each addition This adds it to the list of members.
· Click the Search button to look for people and Resources to add.
· Click Delete to delete selected names.
· Click Print to print your list.

Click OK to return to the Manage Groups dialog box.

See Also:
Manage Groups



Adding Names
Whenever you need to create or modify a list of people, groups or Resources (like when you are inviting 
people or Resources to an Entry), an Add edit box will appear.

If you do not know the name of a person, Resource or group you want to add, click the Search button to 
open the Search dialog box.

To add a person:
Type the person's name or initials in the Add edit box.

You can also enter Organization units with the user's name. Organization units must be separated from 
the name and from each other by slashes (for example: John Smith/CORP/MKTG/EXT or John 
Smith/OU1=CORP/OU2=MKTG/OU3=EXT).

If you do not include the "OU=", then the Organization units must be entered in their correct sequence. If 
you type John Smith/EXT, your Agenda will assume EXT is the first Organization unit. However, if you 
type John Smith///EXT, your Agenda will understand that EXT is the third Organization unit. The spaces 
provided by the other two slashes insert two empty Organization units. Depending on your set-up, a 
person may have as many as four Organization units.

Once you have entered the name or initials in the edit box:
· Click the Add button to accept the addition. This adds the person to the list of people/Resources you 

are creating or editing.

If your Agenda cannot find one unique name with the search parameters you have entered, the Select a 
Name dialog box will open. Select the correct name from this list and click OK to add it to your list.

NOTE: If a person's name has a blank character in it, either in the person's first name (like "Mary Jane") 
or in the surname (like "Wilson Smith"), you must type in a ^ character (Shift + 6) in place of a blank 
space when you enter that person's name. Otherwise your Agenda will assume the second name to be 
the person's surname. For example:

· Write Mary^Jane Johnson, instead of Mary Jane Johnson
· Write Peter Wilson^Smith, instead of Peter Wilson Smith.

To add a Resource:
To add a Resource to the list, type r:, re:, or res: followed by the Resource's name.

You can enter the Resource's number with or without its name. The number must be separated from the 
Resource name by a slash (for example: r:Meeting Room/R3535-1). If you wish to enter the Resource 
number without the Resource name, it must be preceded by a slash (for example: r:/R3535-1).

Once the name is in the edit box:
· Click the Add button to accept the addition. This will add the Resource to the list of people/Resources 

you are creating or editing.

To add a group:
To add a group to the list, type g:, gr:, or grp: followed by the group's name.

Once the name is in the edit box:
· Click the Add button to accept the addition. This will add the entire group to the list of 

people/Resources you are creating.

You can also click the Group button to select a group



See Also:
Directory Search — People
Directory Search — Resources
Directory Search — Groups
Select a Group
Manage Groups



Time Control
The Time Control is displayed when you click the Clock button next to a Time box. This is another way of 
setting the time in a Time box:

Clicking the Clock button next to a Time box displays the Time Control.
You can adjust the Time Control in three ways:
· Click the left or right arrows to move the blue arrow in one-hour intervals. The time selected will be 

displayed in the corresponding Time box
· Click the blue arrow and drag it until it points at the desired time. You can move the Time Control in 

15-minute intervals
· Click directly on the desired time if it is visible in the Time Control.

Click OK when finished.



Replying to an Invitation
You can reply to Meetings that appear in your In-tray, stating whether or not you will attend. For Day 
Events, Daily Notes and Holidays you can decide whether or not to keep them in your Agenda.

You can double-click an Entry in your In-tray to open the View Entry dialog box. You can also view, 
reschedule or reply to an invitation by clicking it with your right mouse button.

If you are replying to a Meeting:
Select the appropriate box from the list ("I will attend", "I will not attend", or "I will confirm later").

· The message "I would prefer another time" can accompany any of the options.
· To send an e-mail message with your reply, click the Mail Message button .

Click OK.

If you are replying to a Day Event, Daily Note or Holiday:
Select from the list one of the three options:

· Keep in Agenda.
· Remove from Agenda.
· Decide Later.

Click OK.

See Also:
In-tray Preferences—Accepted Entries
Mail Message



Select a Group
The Select a Group dialog box is displayed when you click the Group button next to an Add edit box (for 
example, when inviting people and Resources to an Entry). Here you can choose a group (or group 
members) you want included in the list of people/Resources underneath the Add edit box.

1. Select the group types you want to see in the Groups Displayed box.

2. Select a group from the Groups Available list box. The members' names will appear in the Group 
Members list box.

3. To print out a list of groups, choose Print Groups. The print-out will contain a list of all groups, with a 
list of each group's members (up to a maximum of 50 members).

4. To print out a list of the members of a specific group, select the group and choose Print Members. 
The print-out will contain a list of all the group's members.

Click OK to include the selected group's members in the list you are working on.

See Also:
Adding Names
Manage Groups



Preferences
You can personalize your Agenda to suit your needs and habits.

For more information on setting your preferences, click one of the topic headings:

Agenda Preferences
Display
Notification

In-tray Preferences
Entries Accepted 
Entries Refused
Entries Sent Out

Entry Defaults
Meetings
Tasks
Day Events
Daily Notes

General Preferences
Name Formats
Date and Time Formats
Time Zone Preferences

Off-line Preferences
Location
Download
People/Resources
Groups
Reconciliation

Other
Color Coding
Scheduling Preferences



Agenda Preferences — Display
The Display tab of the Agenda Preferences dialog box (Edit menu, Preferences, Agenda) lets you 
customize your Agenda display.

1. Set the Start and End times (the times that will be displayed in the first and last time slots of your Day 
and Week Views) using the arrows or by clicking the Clock button. When Meetings have been 
scheduled at an earlier time than your Start time, your page will begin from the time slot where that 
Entry is scheduled.

2. Select the desired time interval using the drop-down list box. This is the amount of time that each slot 
in your Agenda represents.

3. Choose your preferred time format.

· Select "AM/PM" to display times in the AM/PM format.
· Select "24-Hour" to display times in the 24-hour format (00:00 to 23:59).

4. Select the first day of your week using the drop-down list box. The selected day will be displayed first 
in your Weekly and Monthly Agenda pages.

5. Select the "Show Saturday" and/or "Show Sunday" checkboxes to display them in your Agenda.

6. Select the color coding system you prefer using the drop-down list box. Your Meetings can be color 
coded by Importance level, Attendance status or ownership.

7. Select the desired display options. These options affect which Entries are displayed and how they will
appear in your Agenda.

· Declined Meetings: Declined Meetings will be displayed on your Agenda pages.
· Unconfirmed Meetings: Meetings not yet replied to will be displayed on your Agenda pages, not 

only in your In-tray.
· Start and End times: Meetings' Start and End times will be displayed.
· Title: Meeting Titles will be displayed.
· Location: Meeting locations, when specified, will be displayed.
· Details: Entry Details will be included.
· Icons: Meeting icons will be displayed in your Agenda. Once selected, choose whether you want 

to view all Meeting icons or simply the Information icon (indicating there is information included 
with the Meeting).

Click OK only when finished with both tabs of the dialog box.

See Also:
Color Coding



Agenda Meeting Colors
The Agenda Meeting Colors dialog box will appear when you choose Meeting Colors from the Options 
menu.

To change the color scheme of your Meetings, select one of the three options available using the drop-
down list box:

· Entry ownership
· Importance level
· Attendance status.

Please note that when you choose to color code Meetings by ownership and you open another user's 
Agenda, the Meetings you (and not the Agenda's owner) proposed will appear in blue. This makes it 
easier for you to spot Meetings you can edit in other users' Agendas. (Even if you are in another user's 
Agenda, you can still edit an Entry you proposed.) If you are working in someone else's Agenda as a 
Designate, it will be the Meetings proposed by the Agenda's owner that will appear in blue, since you are 
working in that person's Agenda as though you were the owner.

The display below the edit box will show you what colors will be used to code your Entries.

Click OK when you have made your choice.

See Also:
Agenda Preferences — Display



Agenda Preferences — Notification
The Notification tab of the Agenda Preferences dialog box (Edit menu, Preferences, Agenda) lets you 
decide how your Agenda will notify you and others of new and modified Entries.

You can also choose to have your Agenda check for New Entries at regular intervals.

1. Select "Allow people to send me notifications by e-mail for new Entries" to receive an e-mail notifying 
you of New Entries.

2. To receive a Pop-up Window notifying you of New Entries, select "Pop-up notification of New Entries".

3. To check your Agenda for New Entries at regular intervals, select "Check for New Entries every" and 
type the time interval in the edit box below (there is a 15 minute minimum). The New Entries Alert 
appears on the Status bar when there are new Entries in your Agenda.

4. You can also choose in which cases your Agenda will ask you whether you want to send an e-mail 
message to invited users.

· when I create a meeting: You will be asked whether you want to send an e-mail message every 
time you invite other users to an Entry you have created. (The notification preferences of the 
invited users control which people are included on the Distribution list for this message by 
Default.)

· when I modify a meeting: You will be asked whether you want to send an e-mail message every
time you modify an Entry to which you have invited other users.

· when I delete a meeting: You will be asked whether you want to send an e-mail message every 
time you delete an Entry to which you have invited other users.

Click OK only when finished with both tabs of the dialog box.

See Also:
Entry Notification 



Entry Notification
Depending on your settings (Options, Agenda Preferences, Notification), other users can receive Entry 
notifications by electronic mail.

If the e-mail  notification is on, each time you create or modify an Entry to which other users have been 
invited, your Agenda will ask you if you want to send them an e-mail message.

· Click Yes to send an e-mail message. This opens the Mail Message dialog box.
· Otherwise, click No. Your Entry will still appear in their In-trays and Agendas.

See Also:
Mail Message
All about the Mail
Agenda Preferences —Notification



In-tray Preferences — Accepted Entries
You can set up your preferences for your In-tray folders using the In-tray Preferences dialog box (Edit 
menu, Preferences, In-tray).

The Accepted tab allows you to set your viewing preferences for Entries you have accepted.

· Select "Show Entries dated from today until the next" to limit the number of Entries displayed. Once 
selected, you can set the interval using the drop-down list box. You can choose to view Entries from a
period of days, weeks, months or years. Type the appropriate number in the left-hand box.

· Select "Show Entries dated from today onwards" to view every accepted Entry.

Click OK only when finished with all tabs in the dialog box.

See Also:
All about the In-tray
Entry Defaults — Meetings



In-tray Preferences — Sent Entries
You can set up your preferences for your In-tray folders using the In-tray Preferences dialog box (Edit 
menu, Preferences, In-tray).

The Sent tab allows you to set your viewing preferences for Entries you have sent out.

· Select "Show Entries dated from the last to the next" to limit the number of Entries displayed. Once 
selected, you can set the interval using the drop-down list box. You can choose to view Entries 
spanning a period of days, weeks, months or years. Type the appropriate numbers in the left-hand 
boxes.

· Select "Show Entries dated from today onwards" to view every Entry you have sent.

Click OK only when finished with all tabs in the dialog box.

See Also:
All about the In-tray



In-tray Preferences — Refused Entries
You can set up your preferences for your In-tray folders using the In-tray Preferences dialog box (Edit 
menu, Preferences, In-tray).

The Refused tab allows you to set your viewing preferences for Entries you have refused.

· Select "Show all Entries dated from today to the next" if you want to limit the number of Entries 
displayed. Once selected, you can set the interval using the drop-down list box. You can choose to 
view Entries spanning a period of days, weeks, months or years. Type the appropriate number in the 
left-hand box.

· Select "Show all Entries from today onwards" to view every Entry you refused.

Click OK only when finished with all tabs in the dialog box.

See Also:
All about the In-tray



Scheduling Preferences
The Scheduling Preferences dialog box (Edit menu, Preferences, Scheduling) lets you set the time frame 
your Agenda will look in while searching for available times when you use its Suggest a date/time 
function.

Select the day of the week for which you want to set your preferences.

1. Set your Normal hours by entering the Start and End times in the appropriate boxes. Make changes 
to the Start and End times using the arrow keys to the right of the box or by clicking the Clock button.

2. Set your extended hours by entering the Start and End times in the appropriate boxes.

3. To use the same settings throughout the week, click Apply to all.
Choose the tab of the next day's hours you wish to modify and repeat the same steps.

Click OK only when finished with all tabs in the dialog box.

See Also:
Agenda Preferences — Display



Entry Defaults — Meetings
The Entry Defaults dialog box (Edit menu, Preferences, Entry Defaults) allows you to set the Entry 
Defaults for all the new Entries in your Agenda.

The Meetings tab allows you to set the Default settings for Meetings.

1. Choose the Default settings for the Importance level and Access level by using their drop-down list 
boxes.

2. Set the Default Reminders. Select either the "No Reminder" or "Set Reminder" option. Once the "Set 
Reminder" option is selected, you can set the Reminders options.

3. Choose whether you want your Default Reminder to be a Pop-up Window or an Upcoming Note using
the drop-down list box.

4. Set when you wish to be reminded using the drop-down list box. You can choose to be reminded 
minutes, hours, days, weeks, months, or even years in advance. Type the appropriate number in the 
box on the left.
Note: This Reminder setting will also be the Default for any Entries that you receive from other users. 
That is, this setting will not just apply to your Entries, but also to Entries you receive from others.

Click OK only when finished with all tabs in the dialog box.

See Also:
Using the Reminders



Entry Defaults — Tasks
The Entry Defaults dialog box (Edit menu, Preferences, Entry Defaults) allows you to set the Entry 
Defaults for all the new Entries in your Agenda.

The Tasks tab allows you to set the Default settings for Tasks you create.

1. Choose the Default setting for the Priority and Access levels using the drop-down list boxes.

2. Choose the Default settings for the Task Start and Task Due Reminders.
For each Reminder, select either the "No Reminder" or "Set Reminder" button. Once the "Set 
Reminder" button is selected, you can set the Reminders options.

3. For each Reminder, choose whether you want your Default Reminder to be a Pop-up Window or an 
Upcoming Note using the drop-down list box.

4. Set when you wish to be reminded using the drop-down list box. You can choose to be reminded 
minutes, hours, days, weeks, months, or even years in advance. Type the appropriate number in the 
left-hand boxes.

Click OK only when finished with all tabs in the dialog box.

See Also:
Using the Reminders



Entry Defaults — Day Events
The Entry Defaults dialog box (Edit menu, Preferences, Entry Defaults) allows you to set the Entry 
Defaults for all the new Entries in your Agenda.

The Day Events tab allows you to set the Default settings for Day Events you create.

1. Choose the Default setting for the Access level using the drop-down list box.

2. Set the Default Reminders. Select either the "No Reminder" or "Set Reminder" button. Once the "Set 
Reminder" button is selected, you can set the Reminders options.

3. Choose whether you want your Default Reminder to be a Pop-up Window or an Upcoming Note using
the drop-down list box.

4. Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You 
can choose to be reminded minutes, hours, days, weeks, months, or even years in advance. Type the
appropriate number in the box on the left.
Note: This Reminder setting will not be the Default for Day Events that you receive from other users. 
For those Entries, the Default Reminders are the same as for Meetings.

Click OK only when finished with all tabs in the dialog box.

See Also:
Using the Reminders



Entry Defaults — Daily Notes
The Entry Defaults dialog box (Edit menu, Preferences, Entry Defaults) allows you to set the Entry 
Defaults for all the new Entries in your Agenda.

The Daily Notes tab allows you to set the Default settings for Daily Notes you create.

1. Choose the Default setting for the Access level using the drop-down list box.

2. Set the Default Reminders. Select either the "No Reminder" or "Set Reminder" button. Once the "Set 
Reminder" button is selected, you can set the Reminders options.

3. Choose whether you want your Default Reminder to be a Pop-up Window or an Upcoming Note using
the drop-down list box.

4. Set when you wish to be reminded using the drop-down list box. You can choose to be reminded 
minutes, hours, days, weeks, months, or even years in advance. Type the appropriate number in the 
box on the left.
Note: This Reminder setting will not be the Default for Daily Notes that you receive from other users. 
For those Entries, the Default Reminders are the same as for Meetings.

Click OK only when finished with all tabs in the dialog box.

See Also:
Using the Reminders



Pop-up Reminders
When you set your Reminders, you can choose to be reminded with either an Upcoming Note or a Pop-
up Window.

The Pop-up Window contains all the Reminders active at the time. You can scroll through them by clicking
the Next Reminder button.

As you scroll through your Reminders, different icons will indicate to what kind of Entry your Reminder 
refers. They will appear as follows:

Meeting

Day Event

Holiday

Task

Daily Note
The Title, date, Start time and End time will be displayed, where applicable.

You can handle Reminders in several ways.

· Click Snooze to turn the Reminder off temporarily. A dialog box will appear asking you for how long 
you want your Reminders to snooze.

· Click Clear to turn off the Reminder you are viewing.
· Click Clear all to turn off all active Reminders.

See Also:
Using the Reminders
The Snooze box



Snooze
The Snooze dialog box appears when you choose Snooze in the Reminders dialog box.

The Snooze function lets you turn off the Reminders dialog box for a period of time.

1. To use the Snooze function, set the time interval by using the arrows to the right of the edit box and 
selecting an interval. You can choose to let your Reminders snooze for minutes, hours, days, weeks, 
months, or even years.

2. Type the appropriate number in the edit box to the left.

Click OK when finished.

See Also:
Using the Reminders
Pop-up Reminders



General Preferences — Names
The Names tab of the General Preferences dialog box (Edit menu, Preferences, General) lets you choose
your Name and Resource Formats.

1. Set the format in which you want names to appear by selecting one using the drop-down list box. 
Select the "Generation" checkbox if you want the Agenda to include any possible generational suffix 
when displaying names (for example, John Smith III).

2. Select how you want your Organization units and other organizational information displayed. You 
have two options:

· Use Separator: Items will be separated from the name and each other by slashes, without codes 
for what they indicate.

· Display Org. Field: Items will include codes for what they indicate (i.e. OU# = for Organization 
units, C= for Country, A= for Administrative domain, etc.).

3. Select which Organization units and what other information (Organization, Country and domains) you 
want to appear next to the name. Select the appropriate boxes.

4. Set the format in which you want Resources to appear. You can choose between having the Agenda 
display only the Resource's name or both its name and number in the order of your choice.

Click OK only when finished with all tabs in the dialog box.



General Preferences — Date and Time
The Date and Time tab of the General Preferences dialog box (Edit menu, Preferences, General) allows 
you to set your preferences for the Date and Time Formats.

1. Set the Short Date Format. This is how dates appear in your Date boxes and Views.

· Select the order in which the month, date and year will appear. You will see an example of the 
selected format at the bottom of the Short Date Format box.

· In the Separator box, enter the character you want to divide the month, date and year. Any 
character can be used.

· To display the four-digit year, select the "Century" checkbox. Deselect it to display the year as 
only two digits.

2. Set the Long Date Format. This is how dates will appear in your menus and on the Status bar.

· Select the order in which the month, day and year will appear. You will see an example of the 
selected format at the bottom ofheLong Date Format box.

· Select the formats for the day, date, month and year from their drop-down list boxes.

3. Set the Time Format by selecting either the 12-Hour or 24-Hour display.

Click OK only when finished with all tabs in the dialog box.

See Also:

General Preferences — Names



General Preferences — Time Zones
You choose which time zone to work in using the Time Zones tab of the General Preferences dialog box 
(Edit menu, Preferences, General).

This tab allows you to change the time zone for when you are working off-line, traveling or when 
scheduling Entries with users in another time zone.

1. You can choose your desired time zone in two different ways.

· Choose the name of the time zone from the drop-down list box.
· Select your time zone by selecting the name of the region or country whose time zone you wish 

to use. Click Load regions for a list of countries and regions in the list box. Select the one you 
want.

To return to your system's normal time zone (i.e. the local time zone in which your system has been 
installed) without logging out, click Revert to host's time zone.

2. If the System Operator has given the system's users that right, you can also choose to save the 
changed time zone for future sessions. This could be useful for someone who frequently travels 
between two time zones.

· If you do not have this option, the text "Save time zone change for future sessions" will be gray 
(inactive) and you cannot select this button.

· If you do not wish to save the changed time zone, select "Make time zone change for this session
only."

· If you want to change the time zone permanently, select "Save time zone change for future 
sessions." In the future, you will always log in to the changed time zone. If you wish to use the 
host's time zone again, you'll have to open this dialog box and click Revert to host's time zone. 
To return to your saved time zone without logging out, you can then click Restore saved time 
zone.

Note: If you choose to save your time zone change, the alternative time zone will be your Default time
zone in the future. The only way of making the system's time zone your Default time zone again is to 
enter it in the top edit box (in one of the ways described above) and to select "Save time zone change
for future sessions."

Click OK only when finished with all tabs in the dialog box.



Off-line Preferences — Location
The Off-line Preferences dialog box (Edit menu, Preferences, Off-line) lets you choose preferences for 
your off-line Agenda.

You can use your Agenda on-line or off-line. Before you can use your Agenda off-line you must configure 
your off-line Agenda, which you can do either here while working on-line, or when you sign in to the off-
line Agenda for the first time.

The Location tab allows you to use your Agenda off-line.

1. Choose where to store your off-line Agenda. You can store the file in any Directory.
Click Browse to look for directories and files.

2. Select "Create Directory if none exists" to place your downloaded file in a new Directory.

Click OK only when finished with all tabs in the dialog box.

See Also:
Off-line Preferences — People/Resources
Off-line Preferences — Download Preferences
Off-line Preferences — Groups
Off-line Reconciliation Preferences



Off-line Preferences — Download
The Off-line Preferences dialog box (Edit menu, Preferences, Off-line) lets you choose preferences for 
your off-line Agenda.

The Download tab allows you to set the range of Entries that will be downloaded to your off-line Agenda.

The Download tab allows you to set the range of Entries that will be downloaded to your off-line Agenda.

1. Select the time period of Entries you want to download.

· Select "Download all Entries" to download all the Entries in your Agenda.
· Select "Download Entries from:" to set a time period of Entries to download.

Enter how far back you want your off-line Agenda to include Entries. Use the drop-down list box to
select one of the time intervals (days, weeks, months, or years) and then type the appropriate 
number in the small edit box. Do the same as above to enter how far into the future you would 
like to extend your off-line Agenda.

2. You must also choose if you want to download your Agenda each time you close it. Choose one of the
following options:

· Automatically download: Your Agenda will automatically be downloaded when you quit your on-
line Agenda.

· Prompt before downloading: You will be asked if you want to download to your off-line Agenda 
when you quit your on-line Agenda.

· Do not download: Your Agenda will not be downloaded unless you choose to do so (by choosing
Download to Local File from the File menu).

Click OK only when finished with all tabs in the dialog box.

See Also:
Off-line Preferences — Location
Off-line Preferences — People/Resources
Off-line Preferences — Groups
Off-line Reconciliation Preferences



Off-line Preferences — People/Resources
The Off-line Preferences dialog box (Edit menu, Preferences, Off-line) lets you choose preferences for 
your off-line Agenda.

The People/Resources tab allows you to choose which users' Agendas will be included when you 
download your off-line Agenda.

Add names in the "Download the Agenda(s) of" edit box.

Click OK only when you have finished with all tabs in the dialog box.

NOTE: When you download other users' Agendas, you will only be able to view the Entries you have 
been granted the Access Rights to view by those users.

See Also:
Off-line Preferences — Location
Off-line Preferences — Download Preferences
Off-line Preferences — Groups
Off-line Reconciliation Preferences



Off-line Preferences — Groups
The Off-line Preferences dialog box (Edit menu, Preferences, Off-line) lets you choose preferences for 
your off-line Agenda.

The Groups tab allows you to choose which groups will be included in your off-line Agenda.

· If you do not want to include any groups, select "No groups".
· To download all groups with your Agenda, select "All groups".
· To download only certain groups, select "Select groups". Decide what group types you wish to choose

from: Private, Public (i.e. all the other group types) or both. Your Agenda will display a list of available 
groups. To delete a group from the list, select it and click Delete

Click OK only when finished with all tabs in the dialog box.

NOTE: When you download a group, only a list of the group members' user names will be downloaded, 
not their Agendas. If you wish to download other users' Agendas, you have to use the People/Resources 
tab.

See Also:
Off-line Preferences — Location
Off-line Preferences — Download Preferences
Off-line Preferences — People/Resources
Off-line Reconciliation Preferences



Off-line Preferences — Reconciliation
The Off-line Preferences dialog box (Edit menu, Preferences, Off-line) lets you choose preferences for 
your off-line Agenda.

The Reconciliation tab allows you to control the way in which your on-line and off-line Agendas will be 
reconciled. That is, the way in which your off-line Agenda will be uploaded to your on-line Agenda. You 
can choose to make decisions on a case-by-case basis, or let your Agenda automatically handle certain 
situations.

1. When an Entry has been deleted in the off-line Agenda, you can select to have the Agenda do one of 
two things:

· Show Reconciliation dialog box: This lets you review the deletion and decide whether to make 
it in your on-line Agenda; or

· Delete Entry in Host Agenda: The Agenda will automatically remove the Entry from your on-line 
Agenda without asking you first.

2. When an Entry has been modified in both the off-line and on-line Agendas, you can select to have the
Agenda do one of two things:

· Show Reconciliation dialog box: This lets you review and confirm the change before it is made 
in your on-line Agenda; or

· Update Entry in Host Agenda: The Agenda will automatically update the Entry in your on-line 
Agenda without asking you first.

3. If Meetings are created or modified in both the on-line and off-line Agendas, scheduling conflicts can 
arise when you upload. You can select how the Agenda handles this situation:

· Check for conflicts on upload: If a conflict between off-line and on-line Meetings arise when 
uploading, the Agenda will display information about the conflict and let you decide what should 
be done about it in the Conflicts Detected dialog box.

· Ignore conflicts on upload: The Agenda will not prompt you about any such conflicts when 
uploading.

4. Select the "Redownload Host Agenda after upload" checkbox if you want the reconciled Host Agenda 
to be automatically downloaded after each upload. This option ensures that the off-line Agenda and 
the Host Agenda are identical after every upload. If you deselect this option, the two Agendas can 
differ.

Select OK only when finished with all tabs in the dialog box.

See Also:
Off-line Preferences — Location
Off-line Preferences — People/Resources
Off-line Preferences — Download Preferences
Off-line Preferences — Groups



Palmtop Reconciliation Preferences
Before you exchange data between your Agenda and your palmtop, you should set your Palmtop 
Reconciliation preferences. You do this in the Palmtop Reconciliation Preferences dialog box (Edit menu, 
Preferences, Palmtop).

Here you control the way in which your palmtop calendar file and your Agenda will be reconciled when 
you import the palmtop data to your Agenda. You can choose to make decisions on a case-by-case basis 
or let your Agenda automatically handle certain situations.

Set your preferences in each section of the dialog box.

1. You can either confirm or let the Agenda automatically reconcile Entries that have been deleted from 
the palmtop but left unmodified in your Agenda.

· Select "Confirm before Reconciling" to be able to review the Entry that has been deleted in the 
palmtop and decide case-by-case if you want to delete the Entry from the Agenda.

· If you select "Reconcile Automatically by:", you have to choose which version you always want 
your Agenda to keep. Select the appropriate button.

2. You can either confirm or let the Agenda automatically reconcile Entries that have been modified both 
in the palmtop and in your Agenda.

· Select "Confirm before Reconciling" to be able to review and compare the Palmtop and Agenda 
versions of the modified Entry and decide case-by-case which version to keep.

· If you select "Reconcile Automatically by:", you have to choose which version you always want 
your Agenda to keep. Select the appropriate button.

3. You can select to have your Agenda prompt you when a Scheduling conflict exists after you exchange
data between your palmtop and your Agenda. 

· Select "Check for conflicts on import" to have the Agenda display information about Scheduling 
conflicts and let you choose what to do in the Conflicts Detected dialog box.

· Select "Ignore conflicts on import" if you do not want the Agenda to prompt you about any such 
conflicts when exchanging data with your palmtop.

Click OK once you have set all your preferences.

See Also:
Import Utility
Palmtop Reconciliation
Palmtop Reconciliation — Confirm Entry Deletion
Palmtop Reconciliation — Confirm Entry Modification
Conflicts Detected



User Information
An Information box will appear on screen when you select a user from a Search and click Information. 
An Information box about the current user (i.e. the user that you have signed in as) is called up when you 
choose User Information from the Options menu.

When you click Information in the Search dialog box
The box contains the information available about the person you have selected. The information 
displayed here is entered by the System Operator when they add a person onto the system. Other users' 
information can only be edited by the System Operator.

Click OK to return to the Search dialog box.

When you choose User Information from the Options menu
The box contains the system's information about you (or the user that you signed in as). Depending on 
your system, you may have the right to modify this information.

Click OK when finished.

See Also:
Directory Search — People
Directory Search — Groups



Resource Information
An Information box will appear on screen when you select a Resource from a search and either double-
click the selected Resource's name or click Information.

The box contains the information available about the Resource you have selected. The information 
displayed here is entered by the System Operator when they add a Resource onto the system.

Note: This information can only be edited by the System Operator.

Click OK to return to the Search dialog box.

See Also:
Searching — Resources
Searching — Groups



Access Rights
The Access Rights dialog box (Options menu, Access Rights) lets you give Designate Rights to others. 
Here you decide which of your Entries other users can view in your Agenda and what information they will
see. Furthermore, you choose Default settings for Access Rights in your Agenda in this dialog box

For more information on Access Rights, click one of the following topic headings:

Access Rights — Designate
Access Rights — Scheduling
Access Rights — Viewing Tasks
Access Rights — Viewing
Unable to Invite



Access Rights — Designate
The Access Rights dialog box (Options menu, Access Rights) lets you give Designate Rights to others.

The Designate tab lets you set the rights each Designate has in your Agenda.

1. To grant Designate Rights to a user, select the person's name from the list of users with special 
Access Rights. If the name is not in the list, add it using the edit box.

2. Select the boxes to choose what rights each Designate will have for Entries of each Access level. For 
Meetings, Day Events and Daily Notes, there are three options:

· View times only: The Designate will only have the right to view the times of your Meetings (if you
choose this option, the Designate will not see Daily Notes or Day Events with this Access level in 
your Agenda).

· View/Reply: The Designate will be able to see your complete Entries and reply to invitations in 
your name.

· Modify: The Designate will have the right to modify your Entries.
You can assign different rights to different types of Entries, according to the Access level you have 
assigned your Entries.
NOTE: A user must have the right to modify Entries for at least one Access level to be able to open 
your Agenda as a Designate.

3. Assign Designate Rights for your Tasks. Designates can either have full Designate Rights (i.e. right to
view and modify) or none at all.

4. Instead of setting the rights for each type of Entry individually, you can also choose to grant the user:

· Full Designate Rights: The user will be able to view and modify all Entries.
· No Designate Rights: The user will have no Designate Rights in your Agenda.
· Same as Default: The user's rights will be the same as the Default. Select this option if you do 

not want to give the person any special Access Rights on this tab of the dialog box but still want 
to give them rights on another tab.

5. Delete a name from the list of users by selecting the name and clicking Delete. They will then have 
the Default rights.

6. If you want to choose Default settings, select "Default: Any unlisted person" and choose settings in 
the same way you would for an individual user (see above).

NOTE: It is not recommended to give Designate Rights to every user on the system. Furthermore, the 
names of those users who do give such rights to all users will not appear on everyone's list of possible 
Designates in the Open Agenda dialog box.

Click OK only when finished with all tabs in the dialog box.

See Also:
Access Rights — Viewing
Access Rights — Viewing Tasks
Access Rights — Scheduling
Act as Designate



Access Rights — Viewing
The Access Rights dialog box (Options menu, Access Rights) lets you give Designate Rights to others. 
Here you decide which of your Entries other users can view in your Agenda and what information they will
see. Furthermore, you choose Default settings for Access Rights in your Agenda in this dialog box

The Viewing tab allows you to control what Meetings, Day Events, and Daily Notes in your Agenda will be 
visible to other users.

1. To grant viewing rights to another user, select the person's name from the list of users with special 
Access Rights shown in the list box. If the name is not already in the list, add it using the edit box.

2. Use the checkboxes to choose what viewing rights you want to give the user for Meetings, Day 
Events, and Daily Notes. You set the rights separately for Normal, Confidential and Personal Access 
levels (you cannot block another user from viewing Public Entries).
Note: If you only give the right to view busy times, the user will not be able to view Day Events or 
Notes with that Access level in your Agenda.

3. Instead of setting the rights for each type of Entry individually, you can also choose to grant the user:

· Full viewing rights: The user will have rights to view all Meetings, Day Events, and Notes.
· No viewing rights: The user will only have the right to view Public Meetings, Day Events, and 

Notes in your Agenda. (Public events can always be viewed by all users.)
· Same as Default: The user's rights will be set to be the same as the Default. Select this option if 

you do not want to give the person any special Access Rights on this tab of the dialog box, but 
still want to keep the name on the list in order to set his or her rights on another tab.

4. You can delete a name from the list of users with special Access Rights by selecting the name and 
clicking Delete. They will then revert to having the same rights as the Default.

5. If you want to choose Default settings, select "Default: Any unlisted person" in the list box and choose
settings in the same way you would for an individual user (see above).

Click OK only when finished with all tabs in the dialog box.

See Also:
Access Rights — Viewing Tasks
Access Rights — Scheduling
Access Rights — Designate



Access Rights — Viewing Tasks
The Access Rights dialog box (Options menu, Access Rights) lets you give Designate Rights to others. 
Here you decide which of your Entries other users can view in your Agenda and what information they will
see. Furthermore, you choose Default settings for Access Rights in your Agenda in this dialog box

The Viewing Tasks tab allows you to control what Tasks in your Agenda will be visible to other users.

1. To grant Task viewing rights to another user, select the person's name from the list of users with 
special Access Rights shown in the list box. If the name is not already in the list, add it using the edit 
box.

2. Select the checkboxes to choose what Task viewing rights you want to give the user. You set the 
rights separately for Normal, Confidential and Personal Access levels (you cannot block another user 
from viewing Public Tasks). If you grant users the right to view Tasks of an Access level, they will be 
able to see all the information about those Tasks.

3. Instead of setting the rights for each type of Task individually, you can also choose:

· Full viewing rights: The user will have rights to view all Tasks.
· No viewing rights: The user will only have the right to view Public Tasks in your Agenda. (Public 

Tasks can always be viewed by all users.)
· Same as Default: The user's rights will be set to be the same as the Default. Select this option if 

you do not want to give the person any special Access Rights on this tab of the dialog box, but 
still want to keep the name on the list in order to set his or her rights on another tab.

4. You can delete a name from the list of users with special Access Rights by selecting the name and 
clicking Delete. They will then revert to having the same rights as the Default.

5. If you want to choose Default settings, select "Default: Any unlisted person" in the list box and choose
settings in the same way you would for an individual user (see above).

Click OK only when finished with all tabs in the dialog box.

See Also:
Access Rights — Scheduling
Access Rights — Designate
Access Rights — Viewing



Access Rights — Scheduling
The Access Rights dialog box (Options menu, Access Rights) lets you give Designate Rights to others. 
Here you decide which of your Entries other users can view in your Agenda and what information they will
see. Furthermore, you choose Default settings for Access Rights in your Agenda in this dialog box

The Scheduling tab allows you to control which users can invite you to Entries.

1. To set a user's Scheduling rights, select the person's name from the list of users with special Access 
Rights shown in the list box. If the name is not already in the list, add it using the edit box.

2. Select "Can invite me to events" to give the person the right to invite you to Entries.

3. You can also select "Same as Default." The user's rights will then be set to be the same as the 
Default. Select this option if you still want to keep the user's name on the list in order to set his or her 
rights on another tab.

4. You can delete a name from the list of users with special Access Rights by selecting the name and 
clicking Delete. They will then revert to having the same rights as the Default.

5. If you want to choose Default settings, select "Default: Any unlisted person" in the list box and choose
settings in the same way you would for an individual user (see above).

Click OK only when finished with all tabs in the dialog box.

See Also:
Access Rights — Designate
Access Rights — Viewing
Access Rights — Viewing Tasks



Mail Message
This dialog box is called up when you choose to send an e-mail message concerning an Entry that you 
are creating, editing, deleting or replying to.

The Mail Message dialog box lets you compose, address and send an e-mail message.

1. Create the message's recipient list—invited users, Resource Designates and the Entry's owner are 
included in the list by Default. 

· If your message concerns a new Entry, users must have set their notification preferences to 
receive e-mail notifications about New Entries to be included on the list.

· If you delete a user and then change your mind, you can quickly make the list complete again 
with the checkmark buttons at the top of the dialog box.

2. You can also add additional users, groups and Resources. They will appear in the Distribution list box.

· To delete a person from the list, select their name in the list box and click Delete.
· Click the Checkmark button to add the name in the edit box to its right.
· Click the Search button to look for people, resources and groups.
· The Send key will turn gray (inactive) if there is not at least one person on the Distribution list.

3. Compose your message in the Message to send edit box. Basic information about the corresponding 
Entry will already appear in the edit box. Scroll down to add to the message.
You can cut and paste text from other applications into your message using the standard Control+C 
(copy), Control+X (cut) and Control+V (paste) commands.

4. Choose Send when you are ready to send your message.

See Also:
Replying to an Invitation
Agenda Preferences — Notification



The Agenda Pages
For more information about the Agenda pages, click one of the following topic headings:

All about the Agenda Pages
The Daily Agenda Page
The Weekly Agenda Page
The Monthly Agenda Page
Open an Agenda

Working as a Designate
Working as a Designate
Logging in as a Resource
Opening the Group Agenda as a Designate
Selecting a Designate

Opening others' Agendas
The Group Agenda
Selection for the Group Agenda

Access Rights
Designate Rights
Viewing
Viewing Tasks
Scheduling



The Date Control Bar — Daily Agenda Page
The Date Control Bar appears along the upper edge of your Agenda pages. It lets you turn the pages of 
your Agenda using five buttons.

When you use the Date Control Bar on the Daily Agenda page, the buttons work like this:

moves you back one week
moves you forward one week
moves you back one day
moves you forward one day

opens the Calendar, which allows you to select a specific date that you want to go to in the 
Agenda.
At the far left of the Date Control Bar, you may also see  and/or 

. These arrows indicate that there are more Meetings earlier or later in the day which are not visible 
on-screen at the moment. Scroll up or down to see these Meetings.

See Also:
The Daily Agenda Page
The Day View



The Date Control Bar — Weekly Agenda Page
The Date Control Bar appears along the upper edge of your Agenda pages. It lets you turn the pages of 
your Agenda using five buttons.

When you use the Date Control Bar on the Weekly Agenda page, the buttons work like this:

moves you back four weeks
moves you forward four weeks
moves you back one week
moves you forward one week

opens the Calendar, which allows you to select a specific date that you want to go to in the 
Agenda.
At the far left of the Date Control Bar, you may also see and/or

. These arrows indicate that there are more Meetings earlier or later in one more days which are not
visible on-screen at the moment. Scroll up or down to see these Meetings.

See Also:
The Weekly Agenda Page
The Week View



The Date Control Bar — Monthly Agenda Page
The Date Control Bar appears along the upper edge of your Agenda pages. It lets you turn the pages of 
your Agenda using five buttons.

When you use the Date Control Bar on the Monthly Agenda page, the buttons work like this:

moves you back six months
moves you forward six months
moves you back one month
moves you forward one month

opens the Calendar, which allows you to select a specific date that you want to got to in the 
Agenda

returns the Calendar grid to the Default setting.

See Also:
The Monthly Agenda Page
The Month View



The Daily Agenda Page
The Daily Agenda page is divided into four parts: the Day View, the Task View, the Notes View and the 
Date Control Bar.

You can resize the three Views to suit your needs. You will notice the cursor change when you point at the
splitters between the panes. It will look like this:

Move the splitters by clicking and dragging them to their new location.

See Also:
The Day View
The Task View
The Notes View
The Date Control Bar
Agenda Preferences — Display



The Weekly Agenda Page
The Weekly Agenda page is divided into three parts: The Week View, the Notes View and the Date 
Control Bar.

The Week View and Notes View are both divided into five, six or seven Day Views, depending on your 
Agenda preferences.

You can resize the two views to suit your needs. The cursor will change when you point at the splitters 
between the views. It will look like this:

Click and drag the splitters to move them to a new location.
Each of the Day Views contained in the Week View behave in the same way as the Day View on your 
Daily Agenda page. By double-clicking the heading of any of the day columns, you can bring up the Daily 
Agenda page for that day. When you reschedule a Meeting on screen, you can move it within that day or 
that entire week. In the same way, you can move Day Events and Notes between the different days of the
Note View.

See Also:
Week View 
The Notes View 
The Date Control Bar — Weekly Agenda Page 
Agenda Preferences — Display 



The Monthly Agenda Page
The Monthly Agenda page is divided into two parts: the Month View and the Date Control Bar.

An entire month is displayed here. You can resize individual columns (i.e. weekdays) or rows (i.e. 
individual weeks) in the Month View by clicking and dragging the splitters you want to move with the View 
Resizing Cursor.

To return to the Default grid setting, click the Grid button on the Date Control Bar.

See Also:
The Month View
The Date Control Bar



New Entries
In the In-tray's New Entries folder you will find Entries to which you have not responded. Click the "Folder"
icon to open a list of the Entries.

1. Double-click an Entry Title to open the View Entry dialog box. The contents of the dialog box depend 
on the type of Entry you have selected.

· For Meetings, select the appropriate reply ("I will attend", "I will not attend" or "I will confirm later").
· For Holidays, Day Events and Notes, select whether or not you want to keep the Entry in your 

Agenda.
You may have the option of sending an e- mail message concerning the Entry. If so, click the Mail 
Message button to do this.
Double-click a Recurring Entry or click its icon to list all dates along with icons indicating what kind of 
Entry it is. Double-click individual dates to call up the same dialog boxes as for regular Entries.

2. Click an Entry's icon to view a list of all the people and Resources who have been invited to the Entry.
Next to each name is an icon indicating if and how the Attendee has replied to the Entry:

The person/Resource has accepted the Entry
The person/Resource has refused the Entry
The person/Resource has not yet responded to the Entry
The person/Resource has accepted the Entry, but would prefer another time
The person/Resource has refused the Entry, but would be interested if it were rescheduled.

Your name appears in bold. Double-click it to call up the View Entry dialog box.

3. You can also reply to an Entry by selecting and dragging it into the desired folder. Use the Shift and 
Control keys to select and move multiple Entries at once.

4. Click anywhere on an Entry line with your right mouse button to reply to an Entry without opening up 
its dialog box. You can also use your right mouse button to view or duplicate the Entry or to send an 
e-mail.

Once you have replied to an Entry, your Agenda will put it in the appropriate In-tray folder (as an Entry 
you have either accepted or refused).

See Also:
Mail Message
Replying to an Invitation
In-tray Preferences—Accepted Entries
Viewing a Meeting — General
Viewing a Day Event — General
Viewing a Daily Note — General



Entries you've Accepted
In the In-tray's Entries you've Accepted folder you will find Entries which you are planning to attend or 
keep in your Agenda. Click the "Folder" icon to open a list of the Entries. The time range of the Entries 
shown depends on the preferences you have set (Edit menu, Preferences, In-tray).

1. Double-click an Entry Title to open the View Entry dialog box. The contents of the dialog box depend 
on the type of Entry you have selected.

· For Meetings, select the appropriate reply ("I will attend", "I will not attend" or "I will confirm later").
· For Holidays, Day Events and Notes, select whether or not you want to keep the Entry in your 

Agenda.
Double-clicking a Recurring Entry or clicking its icon will list all dates along with icons indicating what 
kind of Entry it is. Double-click individual dates to call up the same dialog boxes as for regular Entries.

2. Click an Entry's icon to view a list of all the people and Resources invited to the Entry. Next to each 
name is an icon indicating if and how the person or Resource has replied to the Entry:

The person/Resource has accepted the Entry
The person/Resource has refused the Entry
The person/Resource has not yet responded to the Entry
The person/Resource has accepted the Entry, but would prefer another time
The person/Resource has refused the Entry, but would be interested if it were rescheduled.

Your name appears in bold. Double-click it to call up the View Entry dialog box.

3. You can also reply to an Entry by selecting and dragging it into the desired folder. Use the Shift and 
Control keys to select and move multiple Entries at once.

4. Clicking anywhere on an Entry line with your right mouse button will allow you to alter your reply to an
Entry without opening up its dialog box. You can also use the right button to view or duplicate the 
Entry or to send an e-mail.

If you change your reply to an Entry, your Agenda will put it in the appropriate In-tray folder.

See Also:
In-tray Preferences — Accepted Entries
Viewing a Meeting — General
Viewing a Day Event—General
Viewing a Daily Note — General
Replying to an Invitation



Entries you've Sent Out
In the In-tray's Entries you've Sent Out folder you will find Entries which you have created and sent to 
other users. Click the "Folder" icon to open a list of the Entries. The time range of the Entries shown 
depends on the preferences you have set (Edit-menu, Preferences, In-tray).

1. Double-click an Entry Title to open the Edit Entry dialog box. The contents of the dialog box depend 
on the type of Entry you have selected.

· For Meetings, select the appropriate reply ("I will attend", "I will not attend" or "I will confirm later").
· For Holidays, Day Events and Notes, select whether or not you want to keep the Entry in your 

Agenda. 
Double-clicking a Recurring Entry or clicking its icon will list all dates along with icons indicating what 
kind of Entry it is. Double-click individual dates to call up the same dialog boxes as for regular Entries.

2. In this folder, you can delete an Entry you sent out (i.e. cancel it and remove it from all the invited 
users' In-trays and Agendas). Select the Entry you want to delete and select Delete Entry from the 
Edit menu.

3. Click an Entry's icon to view a list of all the people and Resources that you have invited to the Entry. 
Next to each name is an icon indicating if and how the person or Resource has replied to the Entry:

The person/Resource has accepted the Entry
The person/Resource has refused the Entry
The person/Resource has not yet responded to the Entry
The person/Resource has accepted the Entry, but would prefer another time
The person/Resource has refused the Entry, but would be interested if it were rescheduled.

Your name appears in bold. Double-click it to call up the View Entry dialog box. No matter how you 
reply to the Entry, it will always remain an Entry you have sent out, and therefore it will always stay in 
this folder.

4. You can also reply to an Entry by selecting and dragging it into the desired folder. Use the Shift and 
Control keys to select and move multiple Entries at once.

5. Clicking anywhere on an Entry line with your right mouse button will allow you to alter your reply to an
Entry without opening up its dialog box. You can also use the right button to view or duplicate the 
Entry or to send an e-mail.

If you change your reply to an Entry, your Agenda will put it in the appropriate In-tray folder.

See Also:
In-tray Preferences — Entries Sent
Editing a Day Event—General
Editing a Daily Note — General
Editing a Meeting — General



Entries you've Refused
In the In-tray's Entries you've Refused folder you will find Entries which you have refused to attend or to 
keep in your Agenda. Click the "Folder" icon to open a list of the Entries. The time range of the Entries 
shown depends on the preferences you have set (Edit menu, Preferences, In-tray).

1. Double-click an Entry Title to open the View Entry dialog box. The contents of the dialog box depend 
on the type of Entry you have selected.

· For Meetings, select the appropriate reply ("I will attend", "I will not attend" or "I will confirm later").
· For Holidays, Day Events and Notes, select whether or not you want to keep the Entry in your 

Agenda. 
Double-clicking a Recurring Entry or clicking its icon will list all dates along with icons indicating what 
kind of Entry it is. Double-click individual dates to call up the same dialog boxes as for regular Entries.

2. Click an Entry's icon to view a list of all invited people and Resources . Next to each name is an icon 
indicating if and how the person or Resource has replied to the Entry:

The person/Resource has accepted the Entry
The person/Resource has refused the Entry
The person/Resource has not yet responded to the Entry
The person/Resource has accepted the Entry, but would prefer another time
The person/Resource has refused the Entry, but would be interested if it were rescheduled.

Your name appears in bold. Double-click it to call up the View Entry dialog box.

3. You can also reply to an Entry by selecting and dragging it into the desired folder. Use the Shift and 
Control keys to select and move multiple Entries at once.

4. Click anywhere on an Entry line with your right mouse button to alter your reply to an Entry without 
opening its dialog box. You can also use the right button to view or duplicate the Entry or to send an 
e-mail.

If you change your reply to an Entry, your Agenda will put it in the appropriate In-tray folder.

See Also:
In-tray Preferences — Refused Entries
Viewing a Meeting — General 
Viewing a Day Event — General
Viewing a Daily Note — General
Replying to an Invitation



Act as Designate
The Act as Designate dialog box appears when you select Open Agenda, An Agenda as Designate or 
Open Tasks, Modify Other's as Designate from the File menu. Respectively, the dialog box lets you select 
whose Agenda or Task Display you want to open as a Designate.

Select the person from the list of people who have granted you Designate Rights and click OK.

See Also:

Working as a Designate



Check Conflicts
This dialog box appears when you indicate that you want more information about a Scheduling conflict 
(for example, by double-clicking a Meeting that causes conflicts in the New Meeting dialog box, or clicking
View in the Conflicts Found dialog box).

Here you will find more detailed information about conflicts caused by the Meeting that you are creating, 
editing, or rescheduling.

· The left-hand list box shows which attendees have a conflict with the Entry you created.
· The right-hand list box shows the Title of the Meetings that are conflicting with your Meeting in the 

Agenda of the attendee selected in the left-hand list box.

Click OK when finished reading the information.

See Also:
Suggesting Another Date
Creating a Meeting — General
Editing a Meeting — General



Conflict Found
Whenever you reschedule a Meeting and create a conflict in the process, your Agenda will alert you to the
conflict. It will then ask you whether you still want to move the Entry.

You have three options:

· Click Yes to move the Entry despite the conflict.
· Click No to cancel the move.
· Click View to view the conflict before making your decision. This opens the Check Conflicts dialog 

box.

See Also:
Check Conflicts



The Day View
Your day is displayed here, divided into Time slots. The number of minutes a time slot contains depends 
on your Agenda preferences (Edit menu, Preferences, Agenda). Click Today on the Toolbar to view the 
current date or use the arrow buttons to move quickly between days. You can create, modify, view, 
duplicate and delete Meetings in the Day View.

What you see in the Day View depends on the settings you entered on the Display tab of the Agenda 
Preferences dialog box. You can view five, six or seven Day Views at a time, color code your Entries 
according to their Importance level, Attendance status or ownership and select which icons you wish 
displayed. Click the top of a day column to view its Day View. Conflicting Meetings are shown side-by-
side.

Several icons can appear with a Meeting:

you have accepted the Meeting;
you have refused the Meeting;
you have not yet replied to the Meeting;
there is a Description attached to the Meeting;
there is a file attached to the Meeting;
there is more information included with the Meeting;
the Meeting has more than one attendee;
you have set a Reminder for the Entry;

When a Meeting is selected, the Tab key will always select the next Meeting in chronological order for 
you. Shift+Tab will take you in reverse chronological order.

Moving Meetings in the Day View
You can change the duration of a Meeting directly on your Agenda page. When you click on a Meeting, its
frame becomes selected:

Note: The colors depend on the color coding options selected in the Agenda Preferences dialog box and 
your PC's color settings.
The cursor looks like this when it is over the Meeting's frame:

To modify the Start or End Time, select the appropriate frame and drag it to the desired time.
To move the Meeting to a completely different date or time, drag it by selecting any part of the Entry other 
than its frame. When selected, the cursor looks like this:

Your Agenda will resize the Meeting and adjust the display to accommodate any conflicts.
Hold down the Control key while moving a Meeting to move it in five minute increments.

See Also:
Agenda Preferences — Display
Creating a Meeting — General
Editing a Meeting — General 



Week View
The Week View displays one week at a time. Today's date is displayed in red. Click Today on the Toolbar 
to view the current week or use the arrow buttons to move quickly between weeks. You can create, 
modify, view, duplicate and delete Meetings in the Week View.

What you see in the Week View depends on the settings you entered on the Display tab of the Agenda 
Preferences dialog box. You can view five, six or seven Day Views at a time, color code your Entries 
according to their Importance level, Attendance status or ownership and select which icons you wish 
displayed. Click the top of a day column to view its Day View. Conflicting Meetings are shown side-by-
side.

Several icons can appear with a Meeting:

you have accepted the Meeting;
you have refused the Meeting;
you have not yet replied to the Meeting;
there is a Description attached to the Meeting;
there is a file attached to the Meeting;
there is more information included with the Meeting;
the Meeting has more than one attendee;
you have set a Reminder for the Entry;

When a Meeting is selected, the Tab key will always select the next Meeting in chronological order. 
Shift+Tab will take you in reverse chronological order.

Moving Meetings in the Week View
If you proposed a Meeting, you can change its duration directly on your Agenda page. When you click on 
a Meeting, its frame becomes selected:

Note: The colors depend on the color coding options selected in the Agenda Preferences dialog box and 
in your PC's color settings.
The cursor looks like this when it is over the Meeting's frame:

To modify the Start or End Time, select the appropriate frame and drag it to the desired time.
To move the Meeting to a completely different date or time, drag it by selecting any part of the Entry other 
than its frame. When selected, the cursor looks like this:

Your Agenda will resize the Meeting and adjust the display to accommodate any conflicts.
Hold down the Control key while moving a Meeting to move it in five minute increments.

See Also:
The Month View
The Week View
The Task View
The Notes View
The Date Control Bar — Daily Agenda Page





The Month View
The Month View displays six weeks at a time. In the first and last weeks, any grid squares containing 
days from the previous or following month will be in gray. The current day is displayed in yellow with the 
day's number in red. Click Today on the Toolbar to view the current month or use the arrow buttons to 
move quickly between months.

The Month View displays your Meetings, Daily Notes, Day Events and Holidays. The names of Holidays 
appear in red next to the day's number. The left-hand column displays the week numbers for each 
displayed week (click a number to see the Week View for that week).

You can create, modify, view, duplicate and delete Meetings in the Month View. The Month View also lets 
you move Entries that you proposed from one day to another by clicking the Entry and dragging it to 
another grid square. When you click an Entry you proposed and do not release the mouse button, your 
cursor changes to a dragging cursor:

Click an Entry to select it. Once selected, you can scroll through all the Entries in a grid square using the 
up and down arrows on your keyboard. (The More Icon appears in grid squares when there are more 
Entries than can be displayed in the space provided.)

See Also:
The Monthly Agenda Page 
The Week View
The Day View
The Date Control Bar — Monthly Agenda Page



The Task View
Your Tasks will be displayed in this view. Four different kinds of Tasks may be displayed here: Active 
Tasks, Tasks without a Start date but with a Due Date in the future, overdue and completed Tasks.

The Tasks are sorted according to Due Date. Tasks without Due Dates are listed first.

These Tasks are listed in the Task View when viewing the Daily page of the current date:

· Active Tasks (i.e. Tasks whose Start date has passed)
· Tasks without a Start date but with a Due Date in the future
· Overdue Tasks
· Completed Tasks you completed today, or whose Due Date is the current date.

These Tasks are listed in the Task View when viewing a Daily page of a past date:

· Active Tasks whose Start dates had passed on that date
· Completed Tasks if that date was their date of completion or their Due Date
· Overdue Tasks whose Start dates had passed on that date (they will be displayed as Active Tasks if 

their Due Date had not passed).

These Tasks are listed in the Task View when viewing a Daily page for a future date:

· Tasks for which that date is Start or Due Date
· Tasks without Start date but whose Due Date comes after that date.

A small box appears next to each Task, indicating its Status:
The Task is due in the future.
The Task is overdue.
The Task has been completed.

You can mark a Task as completed by clicking its box. Click it again to remove the Completed checkmark.
The Agenda will make all the appropriate changes to your Task.

Some Tasks may also have the following symbols:
Indicates that a Reminder has been set for the Task.
Indicates that the Task has Comments.
Indicates that the Task has an attachment.

You cannot modify another user's tasks when viewing one of their Daily pages unless you are working as 
their Designate. 

You can also select a Task in the Task View and use the Edit, Duplicate and Delete Entry commands 
available from the Edit menu to change its properties.

Completing Tasks in the Task View
There are four ways to mark a Task as completed while working on your Agenda page: 

· Click its box
· Click the Task with your right mouse button and choose Completed from the appearing menu
· Select the Task and choose Edit Entry from the Edit menu to open up the Edit Task dialog box and 

select the "Completion Date" checkbox
· Select the Task and press F5 to open up the Edit Task dialog box and select the "Completion Date" 

checkbox.

NOTE: You cannot modify or add another user's Tasks unless you are working as their Designate.



Printing Selected Tasks in the Task View
To print a selected Task, choose Print Entry from the File menu or press F11.

See Also:
The Task Display
The Day View
The Notes View
The Date Control Bar — Daily Agenda Page



The Notes View
Daily Notes, Holidays, Upcoming Reminders and Day Events are displayed in the Notes View. The Notes 
View appears on both your Daily and Weekly Agenda pages.

Several icons could appear along with an Entry (depending on the options you entered on the Display tab 
of the Agenda Preferences dialog box):

Daily Note
Holiday
Day Event
Upcoming Day Event
Upcoming Meeting
Upcoming Note
Upcoming Task
Upcoming Holiday

Double-click an Entry to open it.

· If you double-click a Holiday or an Entry that you did not propose, the View Entry window is called up.
It gives you more information about the Entry and allows you to reply to it.

· If you double-click an Entry that you proposed, the Edit Entry window is called up.

You can also quickly reply to an Entry by clicking it with your right mouse button and choosing your reply 
from the menu.

Printing Selected Entries in the Notes View
To print a selected Entry, choose Print Selected Entry from the File menu or press F11.

See Also:
The Day View
The Task View
Entry Defaults — Daily Notes



Using the Reminders
If you do not want to use the Default Reminders, you can set individual Reminders by using the 
Reminders tab when you create, edit or view your Entries.

The Entry Defaults dialog box (Edit menu, Preferences, Entry Defaults) lets you set your Reminder 
Default preferences. You can set Default Reminders for Meetings, Tasks, Day Events and Daily Notes. 
There are no Default Reminders for Holidays, but you can set Reminders for individual Holidays when 
you view them.

There are two kinds of Reminders:

· Pop-up Window: A window appears reminding you of your Entry and listing its information. You can 
set the Reminder minutes, hours, days, weeks, months or even years in advance. When your Pop-up 
Reminders are turned on, the Status Bar Bell will appear on the Status bar.

· Upcoming Note. A Note reminding you of the Entry will appear in the Notes View of your Agenda 
pages. It can be set to appear in your Agenda days, weeks, months or years in advance.

See Also:
Entry Defaults — Tasks
Entry Defaults — Day Events
Entry Defaults — Daily Notes
Entry Defaults — Meetings
The Snooze box
Pop-up Reminders 



All about the Mail
Your Agenda works with the Communicator Messenger Mailbox to send messages to others when you 
reply to their invitations or when you create, modify or delete Entries to which you have invited others. 
Furthermore, you can choose whether or not to let other users notify you by e-mail of New Entries that 
you have been invited to.

Each time you create or modify an Entry to which other users have been invited, your Agenda may 
display a message box asking you if you want to send the other users an e-mail message. (This depends 
on your Preferences, which you can set using Edit menu, Preferences, Agenda).

· Click Yes to send an e-mail using the Mail Message dialog box.
· Otherwise, click No. Your Entry will still appear in the In-trays and Agendas of the other users.

Mail Message
The Mail Message dialog box lets you write, edit and send an e-mail.

1. Create the message's recipient list. Invited users and the Entry's owner are included by default.

· If your message concerns a new Entry, users must have selected "Allow people to send me 
notifications by e-mail for new Entries" on the Notification tab of the Agenda Preferences dialog 
box" to be included on the list.

· If you delete a user and then change your mind, you can quickly refresh the list using the 
checkmark buttons at the top of the dialog box.

2. As you add people to the list, their names will appear in the Distribution list box.

· Select user names and click Delete to remove them from the list.
· The Send key will become gray (inactive) if there are no people in the Distribution list.

3. Compose your message in the Message to send edit box. Basic information about the corresponding 
Entry will already appear in the edit box. Scroll down to add to the message.

Click Send to send your message.

See Also:
Adding Names



Color Coding
Your Agenda can color code your Meetings in one of three ways: by Importance Level, Attendance Status 
or Ownership.

If you color code your Meetings by Importance Level, they will appear as follows (the Importance level is 
set when an Entry is created):

Highest

High

Normal

Low

Lowest.
If you color code your Meetings by Attendance Status, they will appear as follows:

Accepted Meetings

Unconfirmed Meetings

Refused Meetings

Accepted Tentative Meetings

Unconfirmed Tentative Meetings

Refused Tentative Meetings.
A Meeting is owned by the person or Resource who proposed it. If you color code your Meetings by 
Ownership, they will appear as follows:

Meetings owned (i.e. proposed) by you

Meetings that you have been invited to

Tentative Meetings owned (i.e. proposed) by you

Tentative Meetings that you have been invited to.
Please note that when you color code Meetings by ownership open another user's Agenda, the Meetings 
you (and not the Agenda's owner) proposed will appear in blue. This makes it easier for you to spot 
Meetings you can edit in other users' Agendas. (Even if you are in another user's Agenda, you can still 
edit an Entry you proposed.) However, if you are working in someone else's Agenda as a Designate, it will
be the Meetings proposed by the Agenda's owner that will appear in blue, since you are working in that 
person's Agenda as though you were the owner.

See Also:
Agenda Meeting Colors



The In-tray
For more information on the In-tray, click one of the following topic headings:

All about the In-tray
New Entries
Entries you've Accepted
Entries you've Refused
Entries you've Sent Out
Replying to an Invitation



Reminders
Your Agenda can remind you of the Entries you have in it. The Reminders can be set up in a number of 
different ways, to suit the demands of your Entries and your schedule.

For more information on setting your Reminders, click one of the following topic headings:

Using the Reminders
Entry Defaults — Meetings
Entry Defaults — Day Events
Entry Defaults — Tasks
Entry Defaults — Daily Notes
Pop-up Reminders 
The Snooze Box



Printing
You can print out your Agenda pages. The layouts for the different types of pages can be designed to 
include only the information you want included on your print-outs. The fonts and margins can also be 
adjusted to suit your needs.

For more information about printing, click one of the following topic headings:

Printing — Agenda Pages 
Printing — In-Tray, Task Display and Selected Entries 
Print Preview

Layout Options
Daily Agenda Pages
Weekly Agenda Pages
Monthly Agenda Pages
Multiweek 
Day Lists
Task List
Fonts
Margins
Saving your Print Layouts



Mail
Your Agenda works with the Messenger Mailbox to send messages to others when you reply to their 
invitations or when you create, modify, or delete Entries to which you have invited others. Furthermore, 
you can choose whether or not to let other users notify you by e-mail of New Entries that you have been 
invited to.

For more information on using mail with your Agenda, click one of the following topic headings:

All about the Mail
Mail Message
Replying to an Invitation
Agenda Preferences — Notification



Searching
You can search for people, groups and Resources using the Directory Search dialog box. This dialog box 
is called up when you click the Search button. By filling in one or more search parameters, you can make 
your search as broad or as narrow as you need.

For more information on searching, click one of the following topic headings:

Selecting Several Users
Directory Search — People
Directory Search — Groups
Directory Search — Resources
The User Information Box
The Resource Information Box
Locate Person



Groups
Your Agenda allows you to create groups of users and Resources. These groups save you time when you
need to invite the same set of people and/or Resources on a regular basis. You can create groups of 
different types, which determine to whom the group will be available.

For more information on groups, click one of the following topic headings:

Manage Groups
Selecting a Group
The Group Agenda
Off-line Preferences — Groups 
Directory Search — Groups



All about the Agenda Pages
Your Agenda can be displayed in three basic formats: Daily, Weekly and Monthly. There are three ways to
open an Agenda: Choose from the Open Agenda options in the File menu, press Control+O or click the 
Open an Agenda button on the Toolbar.

You can view your own or open another user's Agenda, view several users' Agendas together in a Group 
Agenda or work in another user's Agenda as a Designate (if you have the Access Rights).

For more information on Agenda pages, click one of the following topic headings:

See Also:
The Daily Agenda Page
The Weekly Agenda Page
The Monthly Agenda Page
Open an Agenda
The Group Agenda 
Opening the Group Agenda as a Designate



Selection for Group Agenda
The Selection for Group Agenda dialog box will appear when you select Open Agenda, A Group Agenda 
from the File menu or press Control+G.

The Selection for Group Agenda dialog box allows you to select the people and Resources whose 
Agendas' Day Views will be included in the Group Agenda you are about to open.

1. Type the person, Resource or group name in the edit box.

· To add a Resource, type r:, re:, or res: followed by its name.
· To add a group, type g:, gr:, or grp: followed by its name.

2. Once the name is in the edit box:

· Click the Checkmark button to add the name to the list you are creating.
· Click the Search button to search for people, groups or Resources.
· Click the Group button to select a group to add to your list.

3. To delete a name from the list box, select the name and click Delete.

When your list is complete, click OK to open this Group Agenda.

Note: You can reopen this dialog box while working in the Group Agenda by clicking the Modify Group 
Agenda button on the Date Control Bar. This allows you to modify the list of people and Resources 
included in the current Group Agenda.

See Also:
Adding Names
The Group Agenda



Importing & Exporting
You can transfer data between your Agenda and a Hewlett Packard palmtop computer or a data file, 
including various ASCII file formats, Schedule+ files and vCalendar objects.

For more information on importing and exporting, click one of the following topic headings:

General
All about your Agenda's Palmtop Support
Import Utility
Export Utility
Serial Settings
Initial Set-up Procedure for Exporting to the Palmtop
Installing the UniLink Server on your HP Palmtop

vCalendar objects
Working with vCalendar Objects
vCalendar Entries Found
vCalendar Object Details

Palmtop Reconciliation
Palmtop Reconciliation
Preferences
Confirm Entry Deletion
Confirm Entry Modification
Conflicts Detected



All about your Agenda's Palmtop Support
When you export from your Agenda to your HP palmtop, a Calendar file is written on the palmtop. 
Changes made to the palmtop Calendar can then be added to your Agenda by importing the data from 
the palmtop to the Agenda.

When you export to the palmtop, your Agenda will generate a name for the Calendar file being created 
(you can change it to suit your needs). Every time you export to the palmtop specifying this Calendar 
name, any inconsistencies between the file and the Agenda will be dealt with in the reconciliation process.
You can set your Palmtop Reconciliation preferences (Edit menu, Preferences, Palmtop) to let the 
Agenda deal automatically with the details of this process or to let you deal with each inconsistent Entry 
on a case-by-case basis. Either way, reconciliation ensures that your Agenda and the Calendar on your 
palmtop will always be identical after the exportation.

You can also import Entries into your Agenda from a Calendar file on your palmtop. Your Agenda will take 
you through a reconciliation process in the same way as described above to ensure your Agenda and 
palmtop Calendar are identical

You can import Entries that were previously exported from someone else's Agenda—simply choose the 
appropriate palmtop file to import from. However, these Entries will be considered as being created and 
proposed by you.

You should remember that although you can export several Agendas at once, only one palmtop Calendar 
can be imported at one time.

Your Agenda has greater scheduling capabilities than the supported palmtops. As a result, there are some
limits on the information that can be transferred. The Import and Export utilities are intended to help 
mobile users, but the palmtop cannot serve as a replacement for the Agenda. All types of Entries can be 
exported, but Meetings will exist on your palmtop as Appointments, Day Events, Daily Notes and Holidays
will exist as Events, and Tasks will exist as To-do's.

Entries that have more than one attendee can be exported to the palmtop. While working on the palmtop, 
you can edit any aspect of these Entries except the list of people/Resources. When importing such 
Entries into your Agenda, all changes will automatically be updated for every person/Resource included in
the Entry.

When you export Entries to the palmtop, their Reminders will be set by Default (to five minutes before the 
Entry begins).

To exchange data between your Agenda and your palmtop, you will need to perform an initial set-up. This 
process only needs to be done once, unless you let both the main and auxiliary power supplies of your 
palmtop run down.

See Also:
Export Utility
Installing the UniLink Server on your HP Palmtop



Initial Set-up Procedure for Exporting to the Palmtop
This set-up procedure will prepare your palmtop to exchange data with your Agenda. Once completed, 
you will not need to repeat it unless you let both the main and auxiliary power supplies of your palmtop 
run down.

For your Agenda to be able to exchange data with your palmtop, you will need to install the UniLink 
Server on your palmtop.

You must link the PC and the palmtop with the appropriate PC link cable supplied with your palmtop. 
Make sure that the PC's communications port is correctly configured (refer to your computer's user 
manual for information on the ports available and how to identify them). Select the appropriate port from 
the list of options available in the Port edit box.

Set up the following (the following are the Default values and may not need to be changed):

· Set the baud rate to 9600 (other rates do not work well with most palmtops).
· Set the data bits to 8.
· Set the parity to none.
· Set the stop bits to 1.
· Set the flow control to Xon/Xoff.

These settings will give you the best communication results between your Agenda and your palmtop.

Once you have set your communications parameters, click OK to save these settings in your UNISON.INI
file. If you have correctly configured the port, you can install the UniLink Server on your palmtop by 
clicking Link Install. If you have correctly transferred the UniLink Server file (ul.exe), the application 
should start. Click Done to close the dialog box.

See Also:
Export Utility
Installing the UniLink Server on your HP Palmtop



Installing the UniLink Server on your HP Palmtop
For your Agenda to be able to exchange data with your palmtop, you will need to install the UniLink 
Server on your palmtop. You only need to do this the first time you export data to or import data from your 
palmtop, unless you let the main and auxiliary power supplies for your palmtop run down.

The following instructions will help you complete the setup procedure for the HP-100LX and HP-200LX 
palmtops. (Only these palmtops are currently supported.)

1. Connect your palmtop to one of the COM ports on your PC using the PC Link cable supplied with 
your palmtop.

2. Turn on the palmtop and select & to start the Application Manager.

3. Press C to start the DataComm Application.

4. Press MENU C S to open up the settings dialog.

· Set the Baud rate to 9600. (Press Alt+B and use the arrow keys.)
· Set the Interface to Com 1. (Press Alt+I and use the arrow keys.)
· Set the Parity to None. (Press Alt+P and scroll through the box.)
· Set the Data bits to 8. (Press Alt+T and use the arrow keys.)
· Set the Stop Bits to 1. (Press Alt+S and use the arrow keys.)
Press F10 to accept these settings.

5. Press MENU F P to open up the File Transfer Protocol dialog box.
Select XMODEM.
Press F10 to accept these settings.

6. Press MENU F R to open the Receive File dialog box.
Enter UL.EXE in the File name edit box.
Press F10 to accept these settings.

7. Click Link Settings In the Export Utility dialog box, then click Link Install in the Serial Settings dialog
box that is called up.

8. After the file transfer is complete, exit the DataComm Application by pressing MENU F X.

9. On the palmtop, go to the DOS Prompt. (Press &D.)

10. Start the UniLink Server by typing UL.

See Also:
Export Utility
Initial Set-up Procedure for Exporting to the Palmtop



Host Reconciliation
Making your off-line Agenda file and your on-line Agenda consistent with one another when uploading is a
process called reconciliation.

The Host Reconciliation dialog box will appear each time the two Agendas have a Meeting with different 
properties (depending on how you have set your Off-line Reconciliation Preferences—Edit menu, 
Preferences, Off-line).

1. In the top left corner of the dialog box, an icon indicates what type of Entry needs to be reconciled. 
Entries will appear as follows:

Meeting
Day Event
Holiday
Task
Daily Note.

2. Along the upper edge of the dialog box, information is displayed about the Entry's Status in the off-line
and on-line Agendas (deleted, modified, or unmodified).

3. The two list boxes below this contain the details of the change the Agenda has found.

· The upper list box shows the Entry as it appears in the off-line Agenda.
· The lower list box shows the Entry as it appears in the host Agenda.

4. The box at the bottom will ask you how you wish to treat the inconsistency.

· To replace the host Agenda's version of the Entry, click Yes.
· To keep the host Agenda's version, click No.

The Agenda will now continue the reconciliation process.

See Also:
Palmtop Reconciliation 



Conflicts Detected
If Meetings are created or modified in both the on-line and Off-line Agendas, Scheduling conflicts can 
arise between these Entries. When you upload your off-line Agenda, the Conflicts Detected dialog box is 
called up when such conflicts are detected (depending on the Off-line Reconciliation Preferences you 
have set—Edit menu, Preferences, Off-line).

The same kind of conflicts can occur when you import data from a palmtop to your Agenda. When these 
conflicts are detected while you are reconciling your Agenda with the palmtop, the Conflicts Detected 
dialog box will be called up (depending on the Palmtop Reconciliation Preferences you have set—Edit 
menu, Preferences, Palmtop).

1. The dialog box shows you information about the conflict(s):

· The off-line or palmtop Meeting that is causing the conflict(s) is indicated.
· In the left-hand list box, all the Meetings in conflict with the off-line or palmtop Entry are listed.
· When you select a Meeting in the left-hand list box, all the invited people and Resources for 

whom the selected and the off-line or palmtop Entry are in conflict will be listed in the right-hand 
list box.

2. Decide what to do about the conflict(s). Select one of the following buttons:

· Ignore conflict: Select this button to ignore the conflict. The off-line or palmtop Entry will be 
added to the Agenda regardless of the conflicts.

· Reschedule: Select this button to reschedule the off-line or palmtop Entry to another date and/or 
time. The Edit Entry dialog box will appear. Make the necessary changes and click OK.

· Delete off-line/palmtop Entry: Select this button to remove the off-line or palmtop Entry. It will 
not be added to your Host Agenda.

After making your choice, the uploading of your off-line Agenda—or the reconciling of your palmtop with 
your Agenda—will continue.

See Also:
Off-line Reconciliation Preferences
Host Reconciliation
Palmtop Reconciliation Preferences
Palmtop Reconciliation
Editing a Meeting—General



Working with vCalendar Objects
The Agenda can import and export vCalendar objects from files with the extension .vcs. This allows you to
share events with other users, post events on a web site and receive events from other users or web 
sites.

There are three ways to import and export vCalendar Entries. You can use the Import and Export Utilities 
(File menu), you can drag and drop the Entries into or out of your Agenda, or you can copy them via the 
Clipboard using the cut (Control+X), copy (Control+C) and paste (Control+V) commands. Any kind of 
Entry can be imported and exported from any View in this way.

Importing Entries
To add an Entry to your Agenda by dragging and dropping, drag the Entry into your Agenda window. A 
Pop-up dialog box will appear, which will let you add the Entry to your Agenda. If you have more than one 
Agenda open (for example, your Agenda and the Agenda of another user on your system), the Entry you 
drag in will be added to the Agenda in which it is dropped.

When you import an Entry, it will be considered to be created and proposed by you. You will also be listed 
as the only attendee. If other people or Resources were listed as attending the Entry, their names will 
appear on the Details tab, along with any additional information available about the Entry.

You can use the copy (Control+C) and paste (Control+V) commands (also available from the Edit menu) 
to do the same thing by way of the Clipboard. Select a vCalendar object, copy it, then paste it into your 
Agenda.

Exporting Entries
You can export Entries in the same ways you import them. To drag an Entry from your Agenda to another 
application (or to your Windows 95/Windows NT 4.0 desktop), press the Control key and click the Entry. 
Then drag the Entry to the desired location. (Pressing the Control key and clicking the Entry copies the 
item—you will then drag this copy of the Entry to another location.)

You can also do the same thing from one Agenda to another. For example, if you want to invite a user to 
an Entry you have already created, and you have their Agenda open, you can drag the Entry from your 
Agenda to their Agenda: the Entry will appear in their Agenda as a new Entry, and the user will have been
added to the list of people invited to the Entry.

You can use the cut (Control+X), copy (Control+C) and paste (Control+V) commands (also available from 
the Edit menu) to do the same thing by way of the Clipboard. Select an Entry in your Agenda, copy it, then
paste it into its new location (another Agenda or another application). Any application that can paste plain 
text or the vCalendar registered format to the clipboard can open a vCalendar object.

Using the Netscape Plug-in
vCalendar objects are appearing with increasing frequency on web sites as a means of informing people 
about upcoming events. You can import these vCalendar objects to your Agenda using your Netscape 
browser. All you need to do is double-click the vCalendar object's icon. If your Agenda is not running at 
the time, you will be prompted to start it so that the Entry can be imported. Once you have signed in to 
your Agenda, a Pop-up dialog box will appear, which will let you add the Entry to your Agenda. See the 
section Importing Entries (above) for more information.

To take advantage of this Netscape feature, the Netscape vCalendar plug-in must be in the netscape\
programs\plugins Directory. The plug-in file for Windows 95 and Windows NT is npvcal32.dll. Windows 
3.1 and 3.11 users must use the npvcal16.dll plug-in file.

See Also:



vCalendar Entries Found
vCalendar Object Details



vCalendar Entries Found
This pop-up dialog box will appear when you are importing vCalendar Entries into your Agenda. It allows 
you to handle individual Entries and view the details of an event before accepting or rejecting the Entry.

At the top of the dialog box, the number of vCalendar Entries being imported is displayed along with two 
arrow buttons. Clicking these buttons will scroll through the Entries being imported. For each Entry, the 
available information will be displayed, including:

· Type of Entry (the icon to the left)
· Title
· Date (Start and Due dates for Tasks)
· Start and End times (Due time for Tasks)
· Access level
· Importance level (Priority for Tasks)
· Location.

To view other information available about the Entry, click View Details.

To add the Entry currently displayed in this dialog box to your Agenda, click Add Entry. If there is more 
than one Entry, you can add all of them by clicking Add all/Add the Rest (this text will appear if you have 
already handled some of the Entries that were included in this dialog box).

If you do not want to add the Entry to your Agenda, click Reject Entry. The Entry will not be added to 
your Agenda. However, it will not be deleted from the .vcs file (the file from which you are importing the 
Entry).

Click Close to close the dialog box when finished.

See Also:
Import Utility
Working with vCalendar Objects



vCalendar Object Details
Any details included in a vCalendar object will be displayed in this dialog box.

The information here may include a list of occurrences. It can also include comments or additional 
information about the Entry, such as its location or a list of other people or Resources who have been 
invited to it.

NOTE: When you import or export an Entry, any people or Resources invited to it will be listed in the 
comments section of the vCalendar object that is created.

See Also:
vCalendar Entries Found
Working with vCalendar Objects



Palmtop Reconciliation
Palmtop reconciliation is the process of making the palmtop and your Agenda consistent with one 
another. When you import data from a palmtop, the Palmtop Reconciliation dialog box will open to let you 
start and end the reconciliation process.

This dialog box may also be called up when you export data and your Agenda detects inconsistencies 
between the palmtop and your Agenda.

At the top of the dialog box, information about the palmtop file you are importing from (or exporting to) is 
displayed.

You can change your Palmtop Reconciliation preferences before starting the process using this dialog 
box. Click Options to call up the Palmtop Reconciliation Preferences process.

To start the reconciliation, Entry Modification and Conflicts Detected dialog boxes may be called up during
the process.

Once the Agenda has finished the reconciliation (when the Status indicator has reached 100%), click 
Done to return to the Import Utility (or Export Utility) dialog box.

See Also:
Palmtop Reconciliation Preferences
Palmtop Reconciliation — Confirm Entry Deletion
Palmtop Reconciliation — Confirm Entry Modification
Conflicts Detected



Serial Settings
This dialog box is called up when you choose Link Settings in the Export or Import Utility dialog boxes. It 
is used to select which of your PC's serial ports will be used to export data to or import data from your 
palmtop. If you have not exported or imported before, you also install the link between your Agenda and 
your palmtop here.

To choose the serial port that will be used, select the Com Port from the drop-down list box. Click OK.

If this is the first time you are exporting data to or importing data from your palmtop, open the DataComm 
application on your palmtop. Choose "File Receive" from the File menu and enter the file name ul.exe. 
Then click Link Install in this dialog box. You will not need to do this again, unless the batteries on your 
palmtop run down, erasing all the data and applications it contains.

See Also:
Export Utility
Import Utility



Serial Settings
This dialog box is called up when you click Link Settings in the Export or Import Utility dialog boxes. It is 
used to select which of your PC's serial ports will be used to export data to or import data from your 
palmtop. If you have not exported or imported before, you also install the link between your Agenda and 
your palmtop here.

To choose the serial port that will be used, select the Com Port from the drop-down list box. Click OK.

If this is the first time you are exporting data to or importing data from your palmtop, open the DataComm 
application on your palmtop. Choose File Receive from the File menu and enter the file name ul.exe. 
Then choose Link Install in this dialog box. You will not need to do this again, unless the batteries on 
your palmtop run down, erasing all the data and applications it contains.

See Also:
Export Utility
Import Utility



Palmtop Reconciliation — Confirm Entry Deletion
Depending on the preferences you have set (Edit menu, Preferences, Palmtop), the Confirm Entry 
Deletion dialog box may be called up when you are reconciling your palmtop and your Agenda.

The Confirm Entry Deletion dialog box will be displayed when your Agenda detects an Entry that has 
been deleted in the palmtop which has been left unmodified in your Agenda. It gives you all the 
information about the Entry and lets you decide whether or not to delete the Entry in your Agenda.

At the top of the dialog box, an icon indicates which kind of Entry has been deleted. Entries will appear as
follows:

Meeting
Day Event
Holiday
Task
Daily Note.

Information about the Entry is listed in the dialog box. Click Details to see any Description (Comments for
Tasks) that has been included with the Entry. Click Entry Data to return to the general information about 
the Entry.

Choose whether to delete the Entry from your Agenda by selecting one of the option buttons:

· Select "Remove Entry From Agenda" to delete the Entry in your Agenda.
· Select "Keep Entry in Agenda" to keep the Entry. The Entry will then be re-exported to your palmtopso

that the latter is identical to your Agenda after the reconciliation. This overrides the earlier deletion in 
your palmtop.

Click OK to return to the Palmtop Reconciliation dialog box.

See Also:

Palmtop Reconciliation — Confirm Entry Modification



Palmtop Reconciliation — Confirm Entry Deletion
Depending on the preferences you have set (Edit menu, Preferences, Palmtop), the Confirm Entry 
Deletion dialog box may be called up when you are reconciling your palmtop and your Agenda.

The Confirm Entry Deletion dialog box will be displayed when your Agenda detects an Entry that has 
been deleted in the palmtop which has been left unmodified in your Agenda. It gives you all the 
information about the Entry and lets you decide whether or not to delete the Entry in your Agenda.

At the top of the dialog box, an icon indicates which kind of Entry has been deleted. Entries will appear as
follows:

Meeting
Day Event
Holiday
Task
Daily Note.

Information about the Entry is listed in the dialog box. Click Details to see any Description (Comments for
Tasks) that has been included with the Entry. Click Entry Data to return to the general information about 
the Entry.

Choose whether to delete the Entry from your Agenda by selecting one of the option buttons:

· Select "Remove Entry From Agenda" to delete the Entry in your Agenda.
· Select "Keep Entry in Agenda" to keep the Entry. The Entry will then be re-exported to your palmtop, 

so that it is identical to your Agenda after the reconciliation. This overrides the earlier deletion in your 
palmtop.

Click OK to return to the Palmtop Reconciliation dialog box.

See Also:

Palmtop Reconciliation — Confirm Entry Modification 



Palmtop Reconciliation — Confirm Entry Modification
Depending on the preferences you have set (Edit menu, Preferences, Palmtop), the Confirm Entry 
Modification dialog box may be called up when you are reconciling your palmtop and your Agenda.

This dialog box will be displayed when your Agenda detects an Entry that has been modified both in the 
palmtop and in your Agenda. It gives you all the information about both the Agenda version and the 
palmtop version of the Entry, and it lets you decide which one you want to keep in your Agenda.

At the top of the dialog box, an icon indicates which kind of Entry the dialog box concerns. Entries will 
appear as follows:

Meeting
Day Event
Holiday
Task
Daily Note.

Information about the two versions of the Entry is listed below, with double-arrows indicating what has 
been modified. Click Details to see and compare the versions of any Description (Comments for Tasks) 
that has been included with the Entry. Click Entry Data to return to the general information about the 
Entry.

Choose which version of the Entry you would like to keep in your Agenda by selecting one of the buttons 
at the top of the dialog box:

· Select "Keep Agenda version" to keep the version of the Entry that was found in the Agenda. The 
Entry will then be re-exported to your palmtop so that the latter is identical to your Agenda after the 
reconciliation.

· Select "Keep palmtop version" to keep the version of the Entry that was found in the palmtop.

Click OK to return to the Palmtop Reconciliation dialog box.

See Also:

Palmtop Reconciliation — Confirm Entry Deletion



Palmtop Reconciliation — Confirm Entry Modification
Depending on the preferences you have set (Edit menu, Preferences, Palmtop), the Confirm Entry 
Modification dialog box may be called up when you are reconciling your palmtop and your Agenda.

This dialog box will be displayed when your Agenda detects an Entry that has been modified both in the 
palmtop and in your Agenda. It gives you all the information about both the Agenda version and the 
palmtop version of the Entry, and it lets you decide which one you want to keep in your Agenda.

At the top of the dialog box, an icon indicates which kind of Entry the dialog box concerns. Entries will 
appear as follows:

Meeting
Day Event
Holiday
Task
Daily Note.

Information about the two versions of the Entry is listed below, with double-arrows indicating what has 
been modified. Click Details to see and compare the versions of any Description (Comments for Tasks) 
that has been included with the Entry. Click Entry Data to return to the general information about the 
Entry.

Choose which version of the Entry you would like to keep in your Agenda by selecting one of the buttons 
at the top of the dialog box:

· Select "Keep Agenda version" to keep the version of the Entry that was found in the Agenda. The 
Entry will then be re-exported to your palmtop, so that the latter is identical to your Agenda after the 
reconciliation.

· Select "Keep palmtop version" to keep the version of the Entry that was found in the palmtop.

Click OK to return to the Palmtop Reconciliation dialog box.

See Also:

Palmtop Reconciliation — Confirm Entry Deletion



Off-line Agenda Configuration
The Agenda Configuration dialog box appears when you try to sign in to your off-line Agenda without 
having set it up while working on-line. You have to configure your off-line Agenda here before you can 
start using it.

1. Type your user name (the name the system knows you by) in the User edit boxes.

2. Select the time zone for your off-line Agenda from the pull-down list box by selecting a region or 
country in the Regions list box.

3. Type the directory in which you want to store your off-line Agenda file in the Off-line Agenda Directory 
Name edit box. Click Browse to look for and select the right directory.

Click OK to open your off-line Agenda for the first time.



Meetings
Any event you schedule in your Agenda is a Meeting. A Meeting can be an appointment, a course, etc.—
in short, any event that fills a defined block of time.

You can create new Meetings, edit Meetings you proposed and view others' Meetings (depending on the 
Access level the Entry's owner has assigned the Entry).

For more information on Meetings, click one of the following topic headings:

Creating a Meeting 
General
Attendees
Options
Attachments

Editing a Meeting 
General
Attendees
Options
Attachments

Viewing a Meeting 
General
Attendees
Options
Attachments

Related Topics
Repeating 
Entry Defaults — Meetings 
Check Conflicts 
Deleting Recurrences



Creating a Meeting
The New Meeting Window allows you to create a new Meeting.

You can create a new Meeting in five ways: Choose New Meeting from the File Menu, click the New 
Meeting button on the Toolbar, press F2, click an Agenda page with your right mouse button and choose 
New Meeting or double-click a time slot on the Daily and Weekly Agenda pages or a day's grid square on 
the Monthly Agenda page.

1. The New Meeting Window is divided in four parts: General, Attendees, Attachments and Options.

· The General area allows you to schedule a time and date for your Meeting. You can also make 
your Entry repeat and check for conflicts from here.

· The Attendees tab allows you to invite people and Resources to your Meeting.
· The Attachments tab allows you to attach a file to your Meeting.
· The Options tab lets you set your Meeting's Reminders, Access level and Importance level.

2. You can add a description to your Entry at any time using the Details message box.

3. Click the Dates button on the Toolbar to view all instances of this Meeting.

Click Schedule on the Toolbar when finished entering all Meeting information.

See Also:
Creating a Meeting — General 
Creating a Meeting — Attendees
Creating a Meeting — Options
Creating a Meeting — Attachments
Entry Defaults — Meetings
Repeating



Creating a Meeting — General
The General area allows you to schedule your Meeting.

1. Type your Entry's Title in the Title edit box.

2. Type the Location in the Location edit box or click the Resource button on the Toolbar to select from 
available Resources (the Default location is the first Resource name in the list of attendees).

3. Enter the date of your Meeting. Type it directly into the Date box, use the arrows or click the Calendar 
button.

4. Enter the Start and End times. You can use the arrows or click the Clock button.

5. Select the Tentative box if you do not wish to make the Entry official yet.

6. Click Repeating to open the Repeating dialog box and make this Meeting repeat. Click Delete to 
remove unwanted dates from the list (use the Shift and Control keys to select multiple recurrences at 
once).

7. Double-click an Entry in the date list or select it and click Conflicts to check for conflicts. The Check 
Conflicts dialog box will show any conflicts.

Click Schedule only when finished entering all your Meeting information.

See Also:
Creating a Meeting 
Creating a Meeting — Attendees
Creating a Meeting — Options
Creating a Meeting — Attachments
Repeating
Check Conflicts



Creating a Meeting — Attendees
The Attendees tab allows you to invite people and Resources to your Meeting.

You can manage the list of Attendees by doing the following:

· Click the Search button to search for people, groups or Resources.
· Click the Group button to select a group for your list.
· To invite a user, type the name in the Add edit box and click Add.

To invite a Resource, type r:, re:, or res: followed by the Resource's name.
To invite a group, type g:, gr:, or grp: followed by the group's name.

· To delete a name, select it from the list box and click Remove.

Click Schedule only when finished entering all your Meeting information.

See Also:
Creating a Meeting
Creating a Meeting — General
Creating a Meeting — Options
Creating a Meeting — Attachments



Creating a Meeting — Options
The Options tab lets you set the Meeting's Importance and Access levels and Reminders.

1. Select the Meeting's Access level using the drop-down list box.

2. Select the Meeting's Importance level using the drop-down list box.

3. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming Note 
or a Pop-up Window.

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Schedule only when finished entering all your Meeting information.

See Also:
Creating a Meeting
Creating a Meeting — General
Creating a Meeting — Attachments
Creating a Meeting — Attendees



Creating a Meeting — Attachments
The Attachments tab allows you to attach a file to your Meeting.

To attach a file to your Meeting:

1. Click Attach.

2. Select the file you wish to attach to your Entry in the dialog box that opens.

3. Click Open.

· If you change your mind, you can remove the file by clicking Remove.
· To rename the file you are attaching, click Save As.
· If you are working off-line, you cannot attach files.

Click Schedule only when finished entering all Meeting information.

See Also:
Creating a Meeting
Creating a Meeting — General
Creating a Meeting — Attendees 
Creating a Meeting — Options



Editing a Meeting
The Edit Meeting Window allows you to edit an existing Meeting. Any changes made will automatically 
appear in attendees' Agendas as well.

You can edit a Meeting in four ways: Select it and choose Edit Meeting from the File Menu, select it and 
press F5, click it with your right mouse button and choose Edit Meeting or double-click it.

1. The Edit Meeting Window is divided in four parts: General, Options, Attendees and Options.

· The General area allows you to schedule a time and date for your Meeting. You can also make 
your Entry repeat and check for conflicts from here.

· The Attendees tab allows you to invite people and Resources to your Meeting.
· The Attachments tab allows you to attach a file to your Meeting.
· The Options tab lets you set your Meeting's Reminders, Access level and Importance level.

2. You can add a description to your Entry at any time using the Details message box.

3. Click the Dates button on the Toolbar to view all instances of this Meeting.

Click Update on the Toolbar when finished entering all Meeting information.

See Also:
Editing a Meeting — General 
Editing a Meeting — Attendees 
Editing a Meeting — Attachments
Editing a Meeting — Options
Repeating



Editing a Meeting — General
The General area allows you to schedule your Meeting.

1. Type your Entry's Title in the Title edit box.

2. Type the Location in the Location edit box or click the Resource button on the Toolbar to select from 
available Resources (the Default location is the first Resource name in the list of attendees).

3. Enter the date of your Meeting. Type it directly into the Date box, use the arrows or click the Calendar 
button.

4. Enter the Start and End times. You can use the arrows or click the Clock button.

5. Select the Tentative box if you do not wish to make the Entry official yet.

6. Click Repeating to open the Repeating dialog box and make this Meeting repeat. Click Delete to 
remove unwanted dates from the list (use the Shift and Control keys to select multiple recurrences at 
once). Click Dates on the Toolbar if the list of dates is not visible.

7. Double-click an Entry in the date list or select it and click Conflicts to check for conflicts. The Check 
Conflicts dialog box will show any conflicts.

Click Update only when finished entering all Meeting information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Meeting 
Editing a Meeting — Attendees 
Editing a Meeting — Attachments
Editing a Meeting — Options
Repeating



Editing a Meeting — Attendees
The Attendees tab shows the list of people and Resources invited to this Meeting. 

1. An icon appears beside each name, indicating each attendee's reply::

The attendee will attend
The attendee will not attend
The attendee has not yet replied
The attendee will attend but would prefer another time
The attendee would attend if it was scheduled at a more convenient time.

2. Modify the list of people and Resources.

Click Update only when finished entering all Meeting information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Meeting
Editing a Meeting — General
Editing a Meeting — Attachments
Editing a Meeting — Options



Editing a Meeting — Options
The Options tab allows you to set a new Meeting's Importance and Access levels and Reminders.

1. Select the Meeting's Access level using the drop-down list box.

2. Select the Meeting's Importance level using the drop-down list box.

3. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming Note 
or a Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Update only when finished entering all Meeting information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Meeting
Editing a Meeting — General
Editing a Meeting — Attachments
Editing a Meeting — Attendees 
Repeating



Editing a Meeting — Attachments
The Attachments tab allows you to attach a file to your Meeting.

To attach a file to this Meeting:

1. Click Attach.

2. Select the file you wish to attach to your Entry in the dialog box that opens.

3. Click Open.

· If you change your mind, you can remove the file by clicking Remove.
· To rename the file you are attaching, click Save As.
· If you are working off-line, you cannot attach files.

Click Update only when finished entering all your Meeting information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Meeting
Editing a Meeting — General
Editing a Meeting — Attendees 
Editing a Meeting — Options



Suggest Date/Time
The Suggest Date/Time dialog box suggests times at which all invited users and Resources are available.

1. In the date boxes, set the range of dates within which you want to schedule your Meeting. You can 
enter the dates directly into the Date boxes, use the arrows or click the Calendar button.

2. In the Duration box, indicate the amount of time you need for your Entry. Your End time will 
automatically be adjusted.

3. Set the time range. This is the block of time it will search in each day. You can either:

· Select "Between" and set the range using the arrows to the right of the boxes or by clicking the 
Clock button.

· Select "Within normal hours" to have your Agenda use the normal hours you set in your 
Scheduling Preferences.

· Select "Within extended hours" to have your Agenda use the extended hours you set in your 
Scheduling Preferences.

4. In the "Maximum number of suggestions" box, enter the number of suggestions you want displayed.

5. Click List Suggestions to start your search.

6. Select a suggestion from the list. It is then displayed in the Selected time boxes.

7. If you want to adjust the time and date of the selected suggestion, adjust them directly into their 
boxes.

Click OK to accept this time and return to the previous dialog box.

See Also:
Check Conflicts



Available Rooms
When you create a Meeting, you can ask your Agenda to suggest a room where the Meeting will take 
place. Click the Resource button on the Toolbar to open the Available Rooms dialog box.

To add a location to your Meeting:

· Select the name from the list and click OK.
· Otherwise, click Cancel to leave the dialog box without adding a Resource.



Delete Recurrences
The Delete Recurrences dialog box is displayed when you delete a Recurring Entry you created.

You can delete a selected Entry in three ways: Press the Delete key, choose Delete Entry from the Edit 
menu or click it with your right mouse button and choose Delete Event.

· Select all the Entry dates you wish to delete and click Delete. Use the Shift and Control keys to select
multiple recurrences at once.

· Click Delete All to delete all Entry dates.
· Click Cancel to close the dialog box without deleting any Entries.



Viewing a Meeting
The View Meeting window displays information about a Meeting you did not propose. It is called up when 
you double-click a Meeting, select it and choose View Meeting from the File menu, select it and press F5 
or click it with your right mouse button and choose View Meeting.

If you open a Meeting that you proposed, the Edit Meeting window will appear instead.

1. The View Meeting Window is divided in four parts: General, Options, Attendees and Options.

· The General area lets you view its Title, date location and owner and enter your reply.
· The Attendees tab lets you see who is invited to the Meeting.
· The Attachments tab shows any file attached to the Meeting.
· The Options tab lets you set your Meeting's Reminders and view its Access and Importance 

levels.

2. You can view any description in the Details message box.

3. Click the Dates button on the Toolbar to view all instances of this Meeting.

Click Update on the Toolbar when finished viewing the Meeting.

See Also:
Viewing a Meeting — Attendees 
Viewing a Meeting — Options
Viewing a Meeting — Attachments 



Viewing a Meeting — General
The General area lets you reply to a Meeting and view its scheduled time, location and who proposed it.

This area shows your current reply to the Entry ("I will attend", "I will not attend", or "I will confirm later."). 
You can change your reply by selecting the appropriate box.

The option "I would prefer another time" can accompany your reply.

· When it accompanies "I will attend", it means you will attend the Entry but would prefer that it be 
scheduled to a more convenient time.

· When it accompanies "I will not attend", it means you would attend the Meeting if it were scheduled at
a more convenient time.

If the Meeting has recurring dates, a list box at the bottom of the window will show the additional dates 
and your reply to each. If it not shown, click Dates on the Toolbar.

Click Update on the Toolbar when finished viewing the Meeting.

See Also:
Viewing a Meeting 
Viewing a Meeting — Attendees 
Viewing a Meeting — Options
Viewing a Meeting — Attachments 



Viewing a Meeting — Attendees
The Attendees tab lets you view who has been invited to this Meeting.

The names of invited users and Resources are listed here. Beside each name is an icon, indicating each 
attendee's reply:

The attendee will attend
The attendee will not attend
The attendee has not yet replied
The attendee will attend but would prefer another time
The attendee would attend if it was scheduled at a more convenient time.

Click Update on the Toolbar when finished viewing the Meeting.

See Also:
Viewing a Meeting
Viewing a Meeting — General
Viewing a Meeting — Options
Viewing a Meeting — Attachments 



Viewing a Meeting — Attachments
The Attachments tab gives you access to the Entry's attachment, if one has been included (the paper clip 
icon on this tab will turn red if an attachment exists).

1. You can open an attached file by double-clicking the file's icon.

· If your system contains the software that was used to create the file, the application will be 
launched and the file will open.

· Otherwise, you will be asked to associate the file with the appropriate application.

2. Click Save As to save the file in a local directory.

Click Update on the Toolbar when finished viewing the Meeting.

Note: If you are working off-line, you cannot access attached files.

See Also:
Viewing a Meeting
Viewing a Meeting — General
Viewing a Meeting — Attendees 
Viewing a Meeting — Options
Associate



Viewing a Meeting — Options
The Options tab allows you to modify a Meeting's Importance and Access levels, Reminders, and make it 
Tentative.

1. Set the Meeting's Access level using the drop-down list box. If you have invited others to this Meeting,
the Access level you set will apply to them as well. They will not be able to change its Access level in 
their Agendas

2. Set the Meeting's Importance level using the drop-down list box.

3. Select the "Tentative" box if you do not wish to make the Entry official yet. You can make it official 
later using the Edit Entry dialog box.

4. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or
a Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Update on the Toolbar when finished viewing the Meeting.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Viewing a Meeting
Viewing a Meeting — General 
Viewing a Meeting — Attachments
Viewing a Meeting — Attendees 



Deleting a Meeting
There are different ways to dispose of a Meeting you no longer wish to keep in your Agenda. The options 
you have depend on whether or not you proposed the Meeting you wish to remove.

1. If you proposed the Meeting and wish to delete it in its entirety:

· Select it and choose Delete Entry from the Edit menu.
· Click the Entry and press the Delete key.
· Click the Entry with your right mouse button and choose "Delete Meeting" from the appearing 

menu.
This will erase the Entry. If you delete an Entry to which others have been invited, it will be deleted 
from all their Agendas.
NOTE: A message box may ask if you wish to notify other users by e-mail.

2. If you did not propose the Meeting, or proposed it and just wish to not attend it:
· Select the Entry and open the View Entry dialog box. Change your reply on the Reply tab to "I will

not attend".
· Click the Entry with your right mouse button and choose "Will not attend" from the appearing 

menu.
You will also have to deselect "Declined Meetings" on the Display tab of the Agenda Preferences 
dialog box. The Entry will still exist but will not appear in your Agenda.
NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Rescheduled Entry
Moving or Duplicating an Entry 



Day Events
A Day Event is an Entry that is valid for an entire day which does not take up time in your Day View. Day 
Events appear in the Notes View at the bottom of your Daily and Weekly Agenda pages and following 
Meetings and Daily Notes on your Monthly Agenda pages. This icon indicates a Day Event: .

Day Events scheduled by others will appear in the New Entries folder of your In-tray, where you can 
decide whether to keep them in your Agenda.
For more information on Day Events, click one of the following topic headings:

Creating a Day Event 
General
Attendees 
Options

Editing a Day Event 
General
Attendees 
Options 

Viewing a Day Event 
General
Attendees
Options 

Moving or Duplicating an Entry 
Rescheduled Entry
Entry Defaults 



Creating a Day Event
The New Day Event window allows you to create a new Day Event.

You can create a new Day Event in four ways: Choose New Day Event from the File Menu, click the New 
Day Event button on the Toolbar, press F4 or click an Agenda page with your right mouse button and 
choose New Day Event.

The New Day Event window is divided in three parts: General, Attendees and Options.

· The General area allows you to schedule a title and date for your Day Event. You can also make your 
Entry repeat from here.

· The Attendees tab allows you to invite people and Resources to your Day Event.
· The Options tab lets you set your Meeting's Reminders and Access level.

Click Schedule on the Toolbar only when finished entering all Day Event information.

See Also:
Creating a Day Event — General 
Creating a Day Event — Attendees 
Creating a Day Event — Options
Repeating



Creating a Day Event — General
The General area allows you to create a Title and set the date for your new Day Event.

1. Type the Title of the Day Event in the Title edit box.

2. Enter the date of your Day Event. Type it directly into the Date box, use the arrows or click the 
Calendar button

3. Click Repeating to open the Repeating dialog box and make this a Recurring Entry. You can delete 
selected dates by clicking Delete on the Toolbar.

Click Schedule on the Toolbar only when finished entering all Event information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Creating a Day Event 
Creating a Day Event — Attendees 
Creating a Day Event — Options
Repeating



Creating a Day Event — Attendees
The Attendees tab allows you to invite people and Resources to your Day Event.

You can manage the list of Attendees by doing the following:

· Click the Search button to search for people, groups or Resources.
· Click the Group button to select a group for your list.
· To invite a user, type the name in the Add edit box and click Add.

To invite a Resource, type r:, re:, or res: followed by the Resource's name.
To invite a group, type g:, gr:, or grp: followed by the group's name.

· To delete a name, select it from the list box and click Remove.

Click Schedule on the Toolbar only when finished entering all Event information.

See Also:
Creating a Day Event
Creating a Day Event — General 
Creating a Day Event — Options



Creating a Day Event — Options
The Options tab allows you to set a Day Event's Access level and Reminders.

1. Select the Access level using the drop-down list box.

2. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or
a Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Schedule on the Toolbar only when finished entering all Event information.

See Also:
Creating a Day Event
Creating a Day Event — General 
Creating a Day Event — Attendees 



Editing a Day Event
The Edit Day Event Window allows you to edit a Day Event you proposed.

You can edit a Day Event in four ways: Select it and choose Edit Day Event from the Edit Menu, double-
click it, select it and press F5 or click it with your right mouse button and select Edit Day Event.

The Edit Day Event window is divided in three parts: General, Attendees and Options.

· The General area allows you to schedule a title and date for your Day Event. You can also make your 
Entry repeat from here.

· The Attendees tab allows you to invite people and Resources to your Day Event.
· The Options tab lets you set your Meeting's Reminders and Access level.

Click Update on the Toolbar only when finished entering all Event information.

See Also:
Editing a Day Event — Attendees 
Editing a Day Event — General 
Editing a Day Event — Options 



Editing a Day Event — General
The General area allows you to edit a Day Event and its Reminders.

1. Make changes to the Title of the Day Event in the Title edit box.

2. Change the date of your Day Event. Type it directly into the Date box, use the arrows or click the 
Calendar button

3. Click Repeating to open the Repeating dialog box and make this a Recurring Entry. Click Delete to 
remove selected instances.

Click Update on the Toolbar only when finished entering all Event information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Day Event 
Editing a Day Event — Attendees 
Editing a Day Event — Options
Repeating
Moving or Duplicating an Entry



Editing a Day Event — Attendees
The Attendees tab allows you to modify the list of invited people and Resources to your Event.

1. An icon appears beside each name, indicating each attendee's reply:

The attendee has decided to keep the Day Event
The attendee has decided to remove the Day
The attendee has not replied to the Day Event yet.

2. Modify the list of people and Resources.

Click Update on the Toolbar only when finished entering all Event information.

See Also:
Editing a Day Event
Editing a Day Event — General
Editing a Day Event — Options



Editing a Day Event — Options
The Options tab allows you to set a Day Event's Access level and Reminders.

1. Select the Access level using the drop-down list box.

2. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or
a Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Update on the Toolbar only when finished entering all Event information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Day Event
Editing a Day Event — General
Editing a Day Event — Attendees 



Viewing a Day Event
The View Day Event Window allows you to view a Day Event you did not propose.

You can view a Day Event in four ways: Select it and choose View Day Event from the File Menu, double-
click it, select it and press F5 or click it with your right mouse button and select View Day Event.

The View Day Event window is divided in three parts: General, Attendees and Options.

· The General area lets you view its Title and date and enter your reply.
· The Attendees lets you view the people and Resources invited to the Day Event.
· The Options tab lets you set your Meeting's Reminders and view its Access level.

Click Update on the Toolbar only when finished entering all Event information.

See Also:
Viewing a Day Event — General 
Viewing a Day Event — Attendees
Viewing a Day Event — Options



Viewing a Day Event — General
The General area lets you reply to a Day Event and view information.

1. The following information about the Day Event is listed:

· Who proposed the Entry
· Title
· Date

2. This area also shows your current reply to the Entry (Keep in Agenda, Remove from Agenda, Decide 
later). You can change your reply by selecting the appropriate box.

3. If the Event is a recurring Entry, a list box at the bottom of the dialog box will show the additional 
dates and your replies:

for Entries you accepted
for Entries you refused
for Entries you have not replied to yet.

Click Update on the Toolbar only when finished entering all Event information.

See Also:
Viewing a Day Event — Attendees
Viewing a Day Event — Options



Viewing a Day Event — Attendees
The Attendees tab allows you to see the list of the people and Resources invited to the Day Event you are
viewing. In this list, an icon next to each name indicates how attendees have replied to the Entry:

In this list, an icon next to each name indicates how attendees have replied to the Entry:

The attendee has decided to keep the Day Event
The attendee has decided to remove the Day Event
The attendee has not yet replied to the Day Event.

Click Update on the Toolbar only when finished entering all Event information.

See Also:
Viewing a Day Event — General 
Viewing a Day Event — Options 



Viewing a Day Event — Options
The Options tab allows you to view a Day Event's Access level and set Reminders.

To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or a 
Pop-up Window.

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the right. 
Then type the appropriate number in the "For" box.

Click Update on the Toolbar only when finished entering all Event information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Viewing a Day Event — General
Viewing a Day Event — Attendees



Deleting a Day Event
There are different ways to dispose of a Day Event you no longer wish to keep in your Agenda. The 
options you have depend on whether or not you proposed the Day Event you wish to remove.

1. If you proposed the Day Event and wish to delete it in its entirety:

· Select it and choose Delete Entry from the Edit menu.
· Click the Entry and press the Delete key.
· Click the Entry with your right mouse button and choose "Delete Day Event" from the appearing 

menu.
This will erase the Day Event. If other users received a copy of the Event, it will also be deleted from 
their Agendas.
NOTE: A message box may ask if you wish to notify other users by e-mail.

2. If you did not propose the Day Event, or proposed it and just wish to not see it in your Agenda:

· Select the Event and change your reply on the Agenda tab to "Remove from Agenda".
· Click the Event with your right mouse button and choose "Remove from Agenda" from the 

appearing menu.
NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Rescheduled Entry
Moving or Duplicating an Entry 



Daily Notes
Daily Notes are memos you can enter into your Agenda. They appear in the Notes View of your Daily and 
Weekly Agenda pages and following Meetings in the Monthly Agenda page. This icon indicates a Daily 
Note: 

For more information on Daily Notes, click one of the following topic headings:

The Notes View
Creating a Daily Note 

General
Attendees 
Options

Editing a Daily Note 
General
Attendees 
Options

Viewing a Daily Note 
General
Attendees
Options

Entry Defaults — Daily Notes
Moving or Duplicating an Entry
Reschedule



Creating a Daily Note
The New Daily Note window allows you to create a new Daily Note.

You can create a new Daily Note in four ways: Choose New Daily Note from the File Menu, click the New 
Daily Note button on the Toolbar, press F3, double-click the Notes View on your Daily or Weekly Agenda 
page or click an Agenda page with your right mouse button and choose New Daily Note.

The New Daily Note window is divided in three parts: General, Attendees and Options.

· The General area allows you to schedule a title and date for your Daily Note. You can also make your 
Entry repeat from here.

· The Attendees tab allows you to invite people and Resources to your Daily Note.
· The Options tab lets you set your Daily Note's Reminders and Access level.

Click Schedule on the Toolbar only when finished entering all Daily Note information.

See Also:
Creating a Daily Note — General 
Creating a Daily Note — Attendees 
Creating a Daily Note — Options
Repeating



Creating a Daily Note — General
The General area allows you to set the Title and date(s) for your new Daily Note.

1. Type the Title of the Daily Note in the Title edit box. This will be the text of your Note as it will appear 
in your Agenda. It can be up to 64 characters long.

2. Enter the date of your Daily Note in the Date box. You can also use the arrows or click the Calendar 
button.

3. Click Repeating to open the Repeating dialog box and make this a Recurring Entry. You can delete 
selected dates by clicking Delete on the Toolbar.

Click Schedule on the Toolbar only when finished entering all Daily Note information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Creating a Daily Note 
Creating a Daily Note — Attendees 
Creating a Daily Note — Options



Creating a Daily Note — Attendees
The Attendees tab allows you to send copies of your Daily Note to other people and Resources.

You can manage the list of Attendees by doing the following:

· Click the Search button to search for people, groups or Resources.
· Click the Group button to select a group for your list.
· To invite a user, type the name in the Add edit box and click Add.

To invite a Resource, type r:, re:, or res: followed by the Resource's name.
To invite a group, type g:, gr:, or grp: followed by the group's name.

· To delete a name, select it from the list box and click Remove.

Click Schedule on the Toolbar only when finished entering all Daily Note information.

See Also:
Creating a Daily Note 
Creating a Daily Note — General 
Creating a Daily Note — Options



Creating a Daily Note — Options
The Options tab allows you to set a Daily Note's Access level and Reminders.

1. Select the Access level using the drop-down list box.

2. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or
a Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Schedule on the Toolbar only when finished entering all Daily Note information.

See Also:
Creating a Daily Note 
Creating a Daily Note — General
Creating a Daily Note — Attendees 



Editing a Daily Note
The Edit Entry window lets you make changes to a Daily Note you created.

You can open it in four ways: Double-click the Note, select it and choose Edit Daily Note from the Agenda 
Menu, select it and press F5, or click it with your right mouse button and choose Edit Note.

The Edit Daily Note window is divided in three parts: General, Attendees and Options.

· The General area allows you to schedule a title and date for your Daily Note. You can also make your 
Entry repeat from here.

· The Attendees tab allows you to invite people and Resources to your Daily Note.
· The Options tab lets you set your Daily Note's Reminders and Access level.

Click Update on the Toolbar only when finished entering all Daily Note information.

See Also:
Editing a Daily Note — General
Editing a Daily Note — Attendees 
Editing a Daily Note — Options
Repeating



Editing a Daily Note — General
The General area allows you to modify a Daily Note's Title and dates.

1. Modify the Title in the Title box. This will be the text of your Note as it will appear in your Agenda. It 
can be up to 64 characters long.

2. Enter the date of your Daily Note in the Date box. You can use the arrows to the right of the box or 
click the Calendar button.

3. Click Repeating to open the Repeating dialog box and make this a Recurring Entry. You can delete 
selected dates by clicking Delete on the Toolbar.

Click Update on the Toolbar only when finished entering all Daily Note information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Daily Note 
Editing a Daily Note — Attendees 
Editing a Daily Note — Options
Repeating



Editing a Daily Note — Attendees
The Attendees tab allows you to modify the list of people and Resources who will receive a copy of your 
Daily Note.

1. An icon appears beside each name, indicating each attendee's reply:

The attendee has decided to keep the Day Event
The attendee has decided to remove the Day
The attendee has not replied to the Day Event yet.

2. Modify the list of people and Resources.

Click Update on the Toolbar only when finished entering all your information.

See Also:
Editing a Daily Note
Editing a Daily Note — General 
Editing a Daily Note — Options 



Editing a Daily Note — Options
The Options tab allows you to set a Daily Note's Access level and Reminders.

1. Select the Access level using the drop-down list box.

2. To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or
a Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the 
right. Then type the appropriate number in the "For" box.

Click Update on the Toolbar only when finished entering all Event information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Daily Note
Editing a Daily Note — General
Editing a Daily Note — Attendees 



Viewing a Daily Note
The View Daily Note window displays information about the Daily Note you selected.

You can call it up in four ways: You can double-click the Daily Note, select it and choose Open Entry from 
the File menu, select it and press F5 or click it with your right mouse button and choose View Note.

The Edit Daily Note window is divided in three parts: General, Attendees and Options.

· The General area lets you view its Title and date and enter your reply.
· The Attendees tab allows you to invite people and Resources to your Daily Note.
· The Options tab lets you set your Daily Note's Reminders and Access level.

Click Update on the Toolbar only when finished entering all your Daily Note information.

See Also:
Viewing a Daily Note — General
Viewing a Daily Note — Attendees
Viewing a Daily Note — Options



Viewing a Daily Note — General
The General area lets you reply to a Daily Note and view information.

1. The following information about the Daily Note is listed:

· Who proposed the Entry
· Title
· Date.

2. This area also shows your current reply to the Note (Keep in Agenda, Remove from Agenda, Decide 
later). You can change your reply by selecting the appropriate box.

3. If the Note is a recurring Entry, a list box at the bottom of the dialog box will show the additional dates 
and your replies:

for Entries you accepted
for Entries you refused
for Entries you have not replied to yet.

Click Update on the Toolbar only when finished entering all your information.

See Also:
Viewing a Daily Note 
Viewing a Daily Note — Attendees
Viewing a Daily Note — Options



Viewing a Daily Note — Attendees
The Attendees tab allows you to see the list of the people and Resources invited to the Day Event you are
viewing. 

In this list, an icon next to each name indicates how attendees have replied to the Entry:

The attendee is keeping the Daily Note
The attendee has removed the Daily Note
The attendee has not yet replied to the Daily Note.

Click Update on the Toolbar only when finished entering all your Daily Note information.

See Also:
Viewing a Daily Note
Viewing a Daily Note — General 
Viewing a Daily Note — Options



Viewing a Daily Note — Options
The Options tab allows you to view a Daily Note's Access level and set Reminders.

To set a Reminder for this Entry, select the "Remind Me" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming note or a 
Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the right. 
Then type the appropriate number in the "For" box.

Click Update on the Toolbar only when finished entering all your Daily Note information.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Viewing a Daily Note
Viewing a Daily Note — General 
Viewing a Daily Note — Attendees



Deleting a Daily Note
There are different ways to dispose of a Daily Note you no longer wish to keep in your Agenda. The 
options you have depend on whether or not you proposed the Daily Note you wish to remove.

1. If you proposed the Daily Note and wish to delete it in its entirety:

· Select it and choose Delete Entry from the Edit menu.
· Click the Entry and press the Delete key.
· Click the Entry with your right mouse button and choose "Remove from Agenda" from the 

appearing menu.
This will erase the Daily Note. If other users received a copy of the Note, it will also be deleted from 
their Agendas.

2. If you did not propose the Daily Note, or proposed it and just wish to not attend it:

· Double-click it and select "Remove from Agenda" on the Reply tab.
· Click the Note with your right mouse button and choose "Remove from Agenda" from the 

appearing menu.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Rescheduled Entry
Moving or Duplicating an Entry 



Holidays
You can only enter Holidays into the Agenda if you have been given special authorization to do so. On 
your Daily and Weekly Agenda pages, Holidays will be displayed in the Notes View. They will appear next 
to the date in the Monthly Agenda page. Holidays received from others will appear in the New Entries 
folder of your In-tray, where you can decide whether or not to keep them in your Agenda.

This icon indicates a Holiday: .

For more information on Holidays, click one of the following topic headings:

Creating a Holiday
Viewing a Holiday



Creating a Holiday
You can only enter Holidays into the Agenda if you have been given special authorization to do so.

On your Daily and Weekly Agenda pages, Holidays are displayed in the Notes View. They appear next to 
the date on the Monthly Agenda page. This icon indicates a Holiday: . New Holidays appear in the 
New Entries folder of your In-tray, where you can decide whether to keep them in your Agenda.

The Holidays window (Options menu, Holidays) allows you to add and delete company Holidays, if you 
are authorized to do so.

1. Type the name of the Holiday in the Title box.

2. Enter the date of the Holiday. Set the date using the arrows to the right-hand side of the edit box or 
click the Calendar button.

3. Your Holidays will appear in the list box. Click the appropriate button to sort by date or by Title.

4. Delete a Holiday by selecting it in the list box and clicking Delete.

Click OK when finished.

NOTE: You cannot edit Holidays. If you want to make changes to a Holiday, you have to delete it and then
create it again.



Viewing a Holiday
The View Holiday window displays information about the Holiday you have selected. You can call up this 
dialog box in four ways: Double-click it, select it and press F5, click it with your right mouse button and 
choose View Holiday or select it and choose Open Entry from the File menu.

1. The Reply area gives you following information about the Holiday you have selected:

· Title
· Date.
This tab also shows your current reply to the Entry (Keep in Agenda, Remove from Agenda, Decide 
Later). You can change your reply by selecting the appropriate box.

2. The Addressing area allows you to create or modify Reminders for your Holidays. Select the "Set 
Reminder" box if you want to turn on the Reminders function. Once selected, you can set the 
Reminder options.

· Use the "Type" drop-down list box to select whether you want to be reminded with a Pop-up 
Window or an Upcoming note.

· Set when you want to be reminded using the "before start" drop-down list box. You can choose to 
be reminded minutes, hours, days, weeks, months or years in advance. Then type the 
appropriate number in the "For" box.

Click Update only when finished replying to the Holiday.



Tasks
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list. The Task list will appear in the Task View of your Daily 
Agenda page and in your Task Display.

For more information on Tasks, click one of the following topic headings:
The Task Display
The Task View

Creating Tasks
General
Details
Reminders

Editing Tasks
Editing a Task — General
Editing a Task — Reminders
Editing a Task — Details
Deleting a Task 

Preferences
Entry Defaults — Tasks
Access Rights — Viewing Tasks

Working as a Designate
Selecting a Designator
Working as a Designate



Creating a Task — General
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list.

There are six ways to create a new Task: Double-click in the Task View or Task Display, choose New Task
from the File menu, press F7, click the New Task button on the Toolbar, type a Title for a new Task in the 
Task Display edit box or click an Agenda page with your right mouse button and choose New Task.

The General tab allows you to set a new Task's date, time, and options.

1. If your Task has a Due Date, select the Due Date box and enter the date by typing it directly into the 
Date box, using the arrows or clicking the Calendar button. You can set the Start date and Completion
date in the same way.

2. If your Task has a Due time, enter it by typing it directly in the Time box, using the arrows or clicking 
the Clock button. You can set the Start time in the same way. (The corresponding date box must be 
selected in order to enter the time.)

3. Set the Task's Priority using the drop-down list box.

4. Select the Task's Access level using the drop-down list box.

5. If part of your Task has already been completed, use the arrow keys to the right of the Completed box
to select the percentage finished.

Click OK only when finished with all tabs in the dialog box.

See Also:
Creating a Task — Details
Creating a Task — Reminders
Entry Defaults — Tasks
The Task Display



Creating a Task — Reminders
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list.

The Reminders tab allows you to create Reminders for your Tasks. You can set a Reminder for both your 
Start and End date in the same way.

To set a Reminder for this Entry, select the "Set Reminder" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming Note or a 
Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the right. 
Then type the appropriate number in the "For" box.

Click OK only when finished with all tabs in the dialog box.

See Also:
Creating a Task — General
Creating a Task — Details
Using the Reminders
Entry Defaults — Tasks



Creating a Task — Details
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list.

The Details tab allows you to write Comments for your Task. You can also attach an existing file to your 
Task.

You can cut and paste text from other applications into your Task's comments by using the standard 
Control+C (Copy), Control+X (Cut) and Control+V (Paste) commands.

To attach a file to your Task:

1. Click Attach.

2. Select the file you wish to attach to your Entry in the Select File to Attach dialog box that opens.

3. Click Open to close the Select File to Attach dialog box. Your attachment will now appear in the 
Attachment section of the New Task dialog box.

· You can remove the Attachment by clicking Remove.
· You can save the file in a local directory by clicking Save As.
· If you are working off-line, you cannot attach files or access a file that was attached earlier.

Click OK only when finished with all tabs in the dialog box.

See Also:
Creating a Task — General
Creating a Task — Reminders



Editing a Task — General
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list.

You can open the Edit Task dialog box in four ways: You can double-click the Task, select it and choose 
Edit Entry from the Edit menu, select it and press F5 or click it with your right mouse button and choose 
Edit Task.

The General tab allows you to edit an existing Task.

1. If your Task has a Due Date, select the Due Date box and enter the date by typing it directly into the 
Date box, using the arrows or clicking the Calendar button. You can set the Start date and Completion
date in the same way.

2. If your Task has a Due time, enter it by typing it directly in the Time box, using the arrows or clicking 
the Clock button. You can set the Start time in the same way. (The corresponding Date box must be 
selected in order to enter the time.)

3. Set the Task's Priority using the drop-down list box.

4. Select the Task's Access level using the drop-down list box.

5. If part of your Task has already been completed, use the arrow keys to the right of the Completed box
to select the percentage finished.

Click OK only when finished with all tabs in the dialog box.

See Also:
Editing a Task — Details
Editing a Task — Reminders
Entry Defaults — Tasks



Editing a Task — Reminders
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list.

The Reminders tab allows you to create or modify a Reminders for your Task. You can set a Reminder for
both your Start and End date in the same way.

To set a Reminder for this Entry, select the "Set Reminder" checkbox.

· In the first drop-down list box, choose whether you wish to be reminded with an Upcoming Note or a 
Pop-up Window

· Use the next two boxes to set when you want to be reminded. You can choose to be reminded 
minutes, hours, days, weeks, months or years in advance using the drop-down list box on the right. 
Then type the appropriate number in the "For" box.

Click OK only when finished with all tabs in the dialog box.

See Also:
Editing a Task — Details
Editing a Task — General
Using the Reminders
Entry Defaults — Tasks



Editing a Task — Details
A Task is a specific piece of work that you have to do. You can keep track of all your assignments and 
responsibilities by adding them to your Task list.

The Details tab allows you to add or modify comments for your Task. You can also attach an existing file 
to your Task.

You can cut and paste text from other applications into your Task's comments by using the standard 
Control+C (Copy), Control+X (Cut) and Control+V (Paste) commands.

To attach a file to your Task:

1. Click Attach to open the Select File to Attach dialog box.

2. Select the file you wish to attach to your Entry and click Open. Your file should be displayed beside 
the Attach button.

· You can remove the Attachment by clicking Remove.
· You can save the file in a local directory by clicking Save As.
· If you are working off-line, you cannot attach files or access a file that was attached earlier.

Click OK only when finished with all tabs in the Edit Task dialog box.

See Also:
Editing a Task — General
Editing a Task — Reminders



Viewing a Task — General
This dialog box will appear when you open a Task from the Reminder Pop-up dialog box, or when you 
double-click a Task while viewing the Task Display of another user.

At the top of the dialog box, the Description of the Task is displayed, as well as the date on which it was 
created.

The General tab displays the following information:

· Description
· Due date and time
· Start date and time
· % Completed
· Completion date
· Access level
· Priority.

See Also:

Viewing a Task — Details 



Viewing a Task — Details
This dialog box will appear when you open a Task from the Reminder Pop-up dialog box, or when you 
double-click a Task while viewing the Task Display of another user.

At the top of the dialog box, the Description of the Task is displayed, as well as the date on which it was 
created.

The Details tab allows you to view the Task's Comments and Attachments, if one is attached. Click Save 
As to save the file in a local directory.

See Also:
Viewing a Task — General 
Pop-up Reminders 



Deleting a Task
There are three different ways to delete a Task.

To delete the Task in its entirety:

· Select it and choose Delete Task from the Edit menu.
· Click the Task and press the Delete key.
· Click the Task with your right mouse button and choose "Delete Task" from the appearing menu.

See Also:
Moving or Duplicating an Entry



Moving or Duplicating an Entry
The Move Entry dialog box (Edit Menu, Reschedule Entry) lets you move the selected Entry to another 
date or time.

The Duplicate Entry dialog box (Edit Menu, Duplicate Entry) lets you make a copy of the Entry you have 
selected and place it on another date or time.

These two dialog boxes look the same, and you set the new date and time in the same way.

1. Set the new date in the Date edit box. Enter the date by typing it directly into the Date box, using the 
arrows or clicking the Calendar button.

2. If you are moving or duplicating a Meeting, the dialog box will also have edit boxes where you can set
the new times.
Set the start and end times by entering them directly in the Time box, using the arrows or clicking the 
Clock button.

3. If you are moving or duplicating a Meeting, click Suggest Another Date to have your Agenda help 
you find a new time or date to schedule the Entry.

Click OK when finished.

NOTE: A message box may ask if you wish to notify other users by e-mail.

See Also:
Editing a Meeting — General
Suggesting another Date or Time



Reschedule
Depending on the Preferences you set on the Notification tab of the Agenda Preferences dialog box (Edit 
menu, Preferences, Agenda), this dialog box appears when you move an Entry to which you invited 
others. It lets you alert other users by e-mail of time or date changes in the Entry you rescheduled.

· Click Yes to open the Mail Message dialog box and send a message.
· Otherwise, click No. Invited users and Resources will not be notified by e-mail of the changes you 

made.

See Also:
Suggest Date/Time
Moving or Duplicating an Entry



Unable to Invite
When you try to invite a person or Resource whom you do not have the right to invite, this dialog box will 
appear.

All users can control their scheduling access (Options menu, Access Rights, Scheduling). They may 
choose to block certain other users from inviting them to Entries.

Click OK to close the dialog box. Your Agenda will automatically adjust the list of invited people and 
Resources according to your Scheduling Rights.

See Also:
Access Rights — Scheduling



Associate
Netscape Calendar may not always be able to find an application that can open an attachment. In these 
cases, you must associate the file with an application using the Associate dialog box.

Choose one of the following options from the Action drop-down list box:

· Associate allows you to associate the file with an application. Type the application's file name in the 
"Associate with" edit box or find it by clicking Browse. Click OK.

· Execute allows you to run the file from this dialog box without first associating it with an application. 
Do this only if you know that the file is executable despite of an unconventional file extension. Click 
OK. A warning will appear, asking you to reconfirm your action. Click Yes to continue or No to cancel.

· Open allows you to open the file directly from this dialog box. Type the application's file name in the 
Associate with edit box or find it by clicking Browse. Click OK.



Repeating
The Repeating dialog box allows you to make this Entry repeat. This can be useful for scheduling any 
type of event that will take place on a regular basis.

1. Enter the Start date. You can enter it directly into the Date box, use the arrows or click the Calendar 
button.

2. Set the End date by selecting either the "Until" or the "For" box.

· If you select "Until", set the date in the same way as you set the Start date.
· If you select "For", set the duration using the drop-down list box and type the interval in the left-

hand edit box.

3. Select the Include checkboxes to include Saturdays, Sundays and Holidays when scheduling the 
recurring Agenda Entry.

4. Select how you would like your Entry to recur using the Frequency drop-down list box.

Click OK only when finished adding all dates.



All about Entries
There are five different types of Entries that appear on your Agenda pages.

For more information on Entries, click one of the following topic headings:
Meetings 

Creating a Meeting 
Editing a Meeting 
Viewing a Meeting 

Daily Notes 
Creating a Daily Note 
Editing a Daily Note 
Viewing a Daily Note 

Day Events 
Creating a Day Event 
Editing a Day Event 
Viewing a Day Event 

Tasks 
Creating a Task 
Editing a Task 
Viewing a Task 

Holidays 
Creating a Holiday 
Viewing a Holiday 



An Agenda
Displays the Open Agenda dialog box. It allows you to open your own Agenda or an Agenda belonging to 
another user or Resource.



A Group Agenda
Displays the Selection for Group Agenda dialog box. It lets you open a Group Agenda, which allows you 
to view the Day View of several users and Resources of your choice at once.



An Agenda As Designate
Allows you to open an Agenda on behalf of a user or Resource for whom you have Designate Rights.



Open Tasks
Lets you open the Task Display. You can open and edit your own Task Display or view someone else's.



Modify Other's As Designate
Lets you open the Task Display of a user for whom you have Designate Rights.



Open In-tray
Opens the In-tray. This allows you to view Entries you have refused, accepted and have not replied to, as 
well as Entries you sent out.



Download To Local File
Downloads your on-line Agenda to your off-line Agenda. Using this command after making changes to 
your Host Agenda updates your off-line Agenda.



Upload From Local File
Uploads your off-line Agenda to your on-line Agenda. Using this command after making changes to your 
off-line Agenda updates your Host Agenda.



Go Off-line/On-line
Disconnects you from the Server and opens your off-line Agenda if you are currently on-line. Connects 
you to the Server and opens your on-line Agenda if you are currently off-line.



Export Data
Opens the Export Utility dialog box, allowing you to export Agenda data to a file, laptop or palmtop.



Import Data
Opens the Import Utility dialog box, allowing you to import Agenda data from a file, laptop or palmtop.



Print
Opens the Print dialog box, allowing you to print the current View.



Print Entry
Prints the selected Entry.



Close
Closes the active window.



Page Setup
Lets you change the printing options.



Exit
Quits the application.



New Meeting
Lets you create a new Meeting.



New Daily Note
Lets you create a new Daily Note.



New Day Event
Lets you create a new Day Event.



New Task
Lets you create a new Task.



Edit Entry
Lets you edit or view the selected Entry.



Duplicate Entry
Lets you copy the selected Entry using the Duplicate Entry dialog box.



Reschedule Entry
Lets you change the time and/or date of the selected Entry.



Delete Entry
Lets you delete the selected Entry.



Select All
Selects all Entries.



Find Entry
When an Entry is selected in the In-tray, choose Find Entry from the Edit menu to bring    you to the Entry 
in your Agenda



Cut
Cuts the selected Entry from your Agenda and places it in the Clipboard. You can then paste it into an 
editor or an e-mail message in vCalendar format.



Copy
Copies the selected Entry from your Agenda to the Clipboard. You can then paste it into an editor or an e-
mail message in vCalendar format.



Paste
Pastes the Clipboard contents into your Agenda.



Duplicate
Lets you copy the selected Entry using the Duplicate Entry dialog box.



Search Directory
Allows you to find out more information about users and Resources in the Directory.



Locate Person
Lets you see what a user, Resource or group has scheduled at a specific time, if you have the Access 
Rights to view the pertinent information.



Manage Groups
Lets you add, delete or modify groups.



Manage Holidays
Lets you modify the Holiday list (if you have the authorization to do so).



Agenda
Lets you edit your Agenda preferences. This allows you to modify your Agenda's appearance and what 
kind of notification will be given to new Entries.



In-tray
Lets you edit your In-tray preferences. This allows you to select what Entries will be included in the In-
tray.



Scheduling
Lets you edit your scheduling preferences. This allows you to set the time range where others can 
schedule Entries in your Agenda.



Entry Defaults
Lets you edit your default settings for Meetings, Tasks, Day Events and Daily Notes. This allows you to 
set the default Importance level, Access level and Reminders.



General
Lets you edit your Name, Date and Time and Time Zone settings.



Off-line
Lets you edit your off-line preferences. You should customize these settings if you use your Agenda off-
line.



Palmtop
Lets you edit your palmtop reconciliation preferences. This allows you to set how your Agenda will handle 
Entries that are different in your on-line and palmtop Agendas.



User Information
Displays the system's information about you (or the user you have signed in as). If your system allows it, 
you can also modify this information here.



Change Password
Lets you change your sign-in password.



Access Rights
Lets you set Access Rights for people or Resources. This allows you to set what information about your 
Entries other users on the system can view or edit.



Day
Displays the Daily Agenda page.



Week
Displays the Weekly Agenda page.



Month
Displays the Monthly Agenda page.



Refresh All
Refreshes all windows.



Turn Reminders On/Off
Turns the activated Reminders on/off.



Turn Icons On/Off
Turns the icons on/off.



Meeting Colors
Colors your Meetings by Entry ownership, Importance level or Attendance status.



Decrease Row Height
Decreases the space allotted for each time slot.



Increase Row Height
Increases the space allotted for each time slot.



Toolbar
Displays or hides the Toolbar.



Date Toolbar
Displays or hides the Date Control Bar.



Icons
Displays or hides icons.



Status Bar
Displays or hides the Status bar.



Window 1, 2, 
Goes to the specified window.



Contents
Offers an index of Help topics.



Using Help
Provides general instructions on using Help.



About Netscape Calendar
Displays the version number of this application.



Edit Entry
Edits the selected Task.



Duplicate Entry
Duplicates the selected Task.



Delete Tasks
Deletes the selected Task.



Show All Tasks
Displays all existing Tasks.



Show Incomplete Tasks
Displays only incomplete Tasks.



Show Completed Tasks
Displays only completed Tasks.



Show Active Tasks
Displays only active Tasks



Sort Tasks by Description
Sorts listed Tasks alphabetically by Description.



Sort Tasks by Due Date
Sorts listed Tasks by Due Date.



Sort Tasks by Start Date
Sorts listed Tasks by Start Date.



Sort Tasks by Priority
Sorts listed Tasks by Priority.



Sort Tasks by Completion Level
Sorts listed Tasks by Completion Level.



Sort Ascending
Sorts listed Tasks in ascending order.



Sort Descending
Sorts listed Tasks in descending order.



Print Entry
Prints the selected Task.



The Checkmark

Appears beside a name in the In-tray when that user is attending the Entry.



The Blue "X"

Indicates the user has refused this Meeting (in the In-tray).



The Red "X"

Indicates that the user has refused this Meeting (in the Month View of the Agenda's Monthly page or in 
the In-tray).



The Question Mark

Indicates that the user has not yet replied to the Entry (when an Entry's participants are displayed in the 
In-tray).



The Mail Message Button

The Mail Message dialog box opens when you click the Mail Message button. It allows you to send an e-
mail message to other users.



The Calendar Button

The Calendar is opened when you click the Calendar button. It allows you to set a date for an Entry or to 
open Agenda pages on a specific date.
The Calendar button appears in many dialog boxes and on several Toolbars within your Agenda.



The Clock Button

The Time Control is opened when you click the Clock button. It allows you to set a time in the 
corresponding time box.
The Clock button appears in many dialog boxes.



The Checkmark Button

Click this button to accept the information in the edit box to its left.
(For example, when adding a user to a list of people and Resources, enter a name in the edit box. To add 
this name to the list you are creating, click this button.)



The Search Button

The Search Directory dialog box is opened when you click the Search button.
The Search Directory dialog box lets you search the Directory for the names of people, Resources or 
groups within the network.



The Group Button

The Group button lets you do one of two things, depending on the context.
Click this button beside an edit box to call up the Select a Group dialog box. It lets you add an entire 
group of people and/or Resources to a list at once.
Click this button on the Toolbar to call up the Selection for Group Agenda dialog box. Add names to the 
list to see the Day Views of multiple participants in a Group Agenda.



The Modify Group Agenda Button

Appears on the Group Agenda Date Control Bar and allows you to modify the list of users and Resources 
included in the Group Agenda you are viewing.



The Round Checkmark

Indicates that the user accepted the Entry. It appears in people/Resources lists, in Daily and Weekly 
Agenda pages and in recurring Entry lists.



The Round "X"

Indicates that the user has refused the Entry. It appears in people/Resources lists, in Daily and Weekly 
Agenda pages and in recurring Entry lists.



The Round Question Mark

Appears with an Entry when you have not yet indicated whether or not you will attend. It appears in 
people/Resources lists, in your Daily and Weekly Agenda pages and in recurring Entry lists.



The Gray Circle

Appears on the General tab of an Entry dialog box when several instances of a recurring Entry are 
selected.



The Pencil

Appears with Meetings when there is a Description and with Tasks when there are Comments included. 
To view the Description or Comments, open the Entry and select the Details tab.



The Group

Appears in the upper left-hand corner of Meetings on your Daily and Weekly Agenda pages when other 
users or Resources are invited.



The Bell

Appears with Meetings and Tasks on your Daily and Weekly Agenda pages, as well as in your Task 
Display, when a Reminder has been set for the Entry.



The Information Icon

Indicates that there is information included with the Meeting. It appears when you select One Icon on the 
Display tab of the Agenda Preferences dialog box.



The Grid Button

Click the Grid button on the Date Control Bar of your Monthly Agenda page to return the Agenda grid to its
default setting.
(This button is useful if you moved around several of the splitters or resized the window.)



The More Icon

Indicates that there are more Entries in the grid square than what is visible.
You can scroll through the Entries to reach those that are not displayed.



The Day Event Icon

Indicates that the Entry is a Day Event.
It appears in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly 
Agenda page and in the In-tray.



The Note Icon

Indicates that the Entry is a Daily Note.
It appears in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly 
Agenda page and in the In-tray.



The Holiday Icon

This icon indicates that the Entry is a Holiday.
It appears in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly 
Agenda page and in the In-tray. It also appears in the Pop-Up Reminder dialog box when the Reminder is
for a Holiday.



The Attending But Would Like to Reschedule Icons

When this icon appears next to a user name or recurring Entry, it indicates that the user will attend the 
Entry, but would prefer if it were scheduled for another time.

When this icon appears next to a user name in the In-tray, it indicates that the user will attend the event, 
but would prefer if it were scheduled for another time.



The Not Attending But Would Like to Reschedule Icons

When this icon appears next to a user name or recurring Entry, it indicates that the user will not attend but
would attend if it were scheduled for another time.

When this icon appears next to a user name in the In-tray, it indicates that the user will not attend the 
event, but would attend if it were scheduled for another time.



The Recurring Entry Icon

Appears next to recurring Entries in your In-tray.
When it appears in the New Entries folder, it is red.
When it appears in any other folder, it is blue.



The Meeting Icon

Appears next to Meetings in your In-tray.
When it appears in the New Entries folder, it is red.
When it appears in any other folder, it is blue.



The Upcoming Day Event Icon

Reminder for an Upcoming Day Event. It appears in the Notes View of your Daily and Weekly Agenda 
pages.
Double-click the Reminder to open the corresponding Entry.



The Upcoming Meeting Icon

Reminder for an Upcoming Meeting. It appears in the Notes View of your Daily and Weekly Agenda 
pages.
Double-click the Reminder to open the corresponding Entry.



The Upcoming Task Icon

Reminder for an Upcoming Task. It appears in the Notes View of your Daily and Weekly Agenda pages.
Double-click the reminder to open the corresponding Entry.



The Upcoming Note Icon

Reminder for an Upcoming Daily Note. It appears in the Notes View of your Daily and Weekly Agenda 
pages.
Double-click the reminder to open the corresponding Entry.



The Task Icon

Indicates that the Task is not due yet. It appears in the Task View of your Daily Agenda page and in the 
Task Display.



The Overdue Task Icon

Indicates that the Task's Due Date has passed but the task has not yet been marked off as completed. It 
appears in the Task View of your Daily Agenda page and in the Task Display.



The Completed Task Icon

Indicates that the Task has been completed. It appears in the Task View of your Daily Agenda page and in
the Task Display.



The Drag & Drop Cursor

Appears when you click and hold the mouse button on an Entry you can drag to another location.
You can move Entries in this way on the Weekly and Monthly Agenda page and in the In-tray.



The Cannot Drop it Here Cursor

Appears when you drag an Entry to a place where you cannot drop it.
(For example, if you drag a Daily Note in the Week View and try to drop it in one of the time slots.)



The View Resizing Cursor

Allows you to resize the views of a selected Meeting on any of your Agenda pages. Click any of the 
splitters that divide the views to allow yourself to resize the view.



The Moving Cursor

Allows you to move a selected Meeting on your Daily and Weekly Agenda pages. Point at any part of the 
frame around a selected Meeting (other than the two handles at the centre of the upper and lower edges) 
to be able to drag the Entry to another time slot.
You cannot move an Entry that someone else proposed.



The Resizing Cursor

Allows you to change the duration of a selected Meeting on your Daily and Weekly Agenda pages. Click 
either of the two handles at the centre of the upper and lower edges of a selected Meeting to be able to 
stretch or contract the Entry and change its duration.
You cannot resize an Entry that someone else proposed.



The Open In-tray Button

Click this button on the Toolbar to open your In-tray.



The Open Agenda Button

Click this button on the Toolbar to open an Agenda.



The Open Tasks Button

Click this button on the Toolbar to open your Task Display.



The View Day Button

Click this button on the Toolbar to open the Daily View.



The View Week Button

Click this button on the Toolbar to open the Weekly View.



The View Month Button

Click this button on the Toolbar to open the Monthly View.



The New Meeting Button

Click this button on the Toolbar to open the New Meeting window.



The New Day Event Button

Click this button on the Toolbar to open the New Day Event window.



The New Task Button

Click this button on the Toolbar to open the New Task window.



The New Daily Note Button

Click this button on the Toolbar to open the New Daily Note window.



The Print Button

Click this button on the Toolbar to call up the Print dialog box and select from the printing options.



The About a Day Event Icon

Appears in the Pop-Up Reminder, vCalendar Entry found and Reconciliation dialog boxes, indicating that 
the dialog box refers to a Day Event.



The About a Meeting Icon

Appears in the Pop-Up Reminder, vCalendar Entry found and Reconciliation dialog boxes, indicating that 
the dialog box refers to a Meeting.



The About a Task Icon

Appears in the Pop-Up Reminder, vCalendar Entry found and Reconciliation dialog boxes, indicating that 
the dialog box refers to a Task.



The About a Note Icon

Appears in the Pop-up Reminder, vCalendar Entry Found and Reconciliation dialog boxes, indicating that 
the dialog box refers to a Daily Note.



The About a Holiday Icon

Appears in the Pop-up Reminder, vCalendar Entry Found and Reconciliation dialog boxes, indicating that 
the dialog box refers to a Holiday.



The Next Reminder Button

Brings up the next Reminder in the Pop-Up Reminder dialog box (if you have more than one Reminder).



The Left Arrow

Appears on the Date Control Bars of Daily, Weekly and Monthly Agenda pages, as well as on the 
Calendar.
On the Daily Date Control Bar, this button takes you to the previous day.
On the Weekly Date Control Bar, this button takes you to the previous week.
On the Monthly Date Control Bar and the Calendar, this button takes you to the previous month.



The Right Arrow

Appears on the Date Control Bars of Daily, Weekly and Monthly Agenda pages, as well as on the 
Calendar.
On the Daily Date Control Bar, this button takes you to the next day.
On the Weekly Date Control Bar, this button takes you to the next week.
On the Monthly Date Control Bar and the Calendar, this button takes you to the next month.



The Today Button

Appears on the Date Control Bars of Daily, Weekly and Monthly Agenda pages, as well as on the 
Calendar.
On the Daily Date Control Bar, this button takes you to today's Daily Agenda page.
On the Weekly Date Control Bar, this button takes you to the current week's Weekly Agenda page.
On the Monthly Date Control Bar, this button takes you to the current month's Monthly Agenda page.
Click this button on the Calendar to open the current page of the type of Agenda you currently are 
viewing.



The Double Left Arrow

Appears on the Date Control Bars of Daily, Weekly and Monthly Agenda pages, as well as on the 
Calendar.
On the Daily Date Control Bar, this button takes you to the previous week.
On the Weekly Date Control Bar, this button takes you to the previous month.
On the Monthly Date Control Bar, this button takes you back six months.
On the Calendar, this button takes you back a year.



The Double Right Arrow

Appears on the Date Control Bars of Daily, Weekly and Monthly Agenda pages, and on the Calendar. 
On the Daily Date Control Bar, this button takes you to the next week.
On the Weekly Date Control Bar, this button takes you to the next month.
On the Monthly Date Control Bar, this button takes you forward six months.
On the Calendar, this button takes you forward a year.



The Paperclip

Indicates that there is a file attached to the Meeting or Task. It appears in your Daily and Weekly Agenda 
pages, as well as in your Task Display.
To open the attachment, go to the Details tab of the Entry.



The Cannot View Meeting Icon

Indicates that you are not authorized to view this Entry. It appears in your Daily and Weekly Agenda 
pages.



New Entries Alert

Appears on the Status bar, indicating there are new Entries in your In-tray.



The Off-line Icon

This icon indicates that you are currently working off-line (i.e. not connected to the server). It appears on 
the right side of the Status bar.



The On-line Icon

Indicates that you are currently working on-line (i.e. connected to the server). It appears to the right on the
Status bar.



Calendar Icon

Appears on your screen when you minimize the Agenda's window.



Alert Icon

When the Agenda's window is minimized, the Calendar icon changes to the Alert icon when new Entries 
appear in your In-tray.



The Upcoming Holiday Icon

This icon is a Reminder for an upcoming Holiday. It appears in the Notes View of your Daily and Weekly 
Agenda pages.
Double-clicking the icon opens the corresponding Entry.



There's More Entries Above

Appears in the Date Control Bar of your Daily, Weekly and Group Pages, indicating that there are Entries 
earlier in the time frame which are not being displayed. Scroll up to see these Entries.



There's More Entries Below

Appears in the Date Control Bar of Daily, Weekly and Group Pages, indicating that there are more Entries
later in the time frame which are not being displayed. Scroll down to see these Entries.



There's More Entries Above and Below

Appear in the Date Control Bar of Daily, Weekly and Group Pages, indicating that there are more Entries 
earlier and later in the time frame which are not being displayed. Scroll up and down to see these Entries.



Group Types
There are four group types: public, private, administrative and members only. Not all types will be 
available in every case or to every user. Some dialog boxes have an All button to display all groups.
· Public groups are available to everyone on the system.
· Private groups are only available to their creators.
· Administrative groups are only available to those people who have been given the right to create and 

administer them (the System Operator controls this).
· Members only groups are available to the members of the group.



On-line
Connected to the server. You can view information located on the server (for example, other users' 
Agendas, attachments).



Off-line
Not connected to the server. You cannot view information located on the server (for example, you cannot 
view other users' Agendas, except those you have downloaded with your off-line Agenda).



Organization unit 
This can be any subdivision of your organization and is related to your e-mail address. For more 
information, consult your e-mail software manual.



Domain
This makes up part of your e-mail address. For more information, consult your e-mail software manual.



E-mail
This is a contraction of the term electronic mail. It is the system that sends messages from one computer 
terminal to another.



Time slot
A time slot is the individual block of time represented on your Agenda's Day and Week Views as a 
rectangle. You can adjust them in two ways:

· Choose Decrease Row Time or Increase Row Time from the View menu
· Change the value in the "Interval" drop-down list box on the Display tab of the Agenda Preferences 

dialog box (Edit menu, Preferences, Agenda).



Resource
A Resource is an inanimate object that has its own Agenda, such as a conference room or a piece of 
equipment.



Server
The server is the computer to which the workstations of a network are connected. It is where the 
centralized database of all user data is kept.



Search Parameter
Defines your search by restricting it to a specific set of information.



Default
The pre-set selection for an option that the program uses unless otherwise specified.



Entry
Anything that appears in the In-tray or on an Agenda page (Meetings, Tasks, Daily Notes, Holidays, Day 
Events, etc.).



Time Control

Clicking  next to a Time box displays the Time Control.
You can adjust the Time Control in three ways:
· Click the left or right arrows to move the blue arrow in one-hour intervals. The time selected will be 

displayed in the corresponding Time box.
· Click the blue arrow and drag it until it points at the desired time. You can move the Time Control in 

15-minute intervals.
· Click directly on the desired time if it is visible in the Time Control.

Click OK when finished.



Importance Level
The Agenda can assign different levels of importance to Meetings.

Meetings color-coded by Importance will appear as follows:

Highest
High
Normal
Low
Lowest



Attendance Status
The Attendance Status of a Meeting indicates how the user has (or has not) responded to it.

Meetings color coded by Attendance Status appear as follows:

Accepted Meetings
Unconfirmed Meetings
Refused Meetings
Accepted Tentative Meetings
Unconfirmed Tentative Meetings
Refused Tentative Meetings



Ownership
A Meeting is owned by the person or Resource who proposed it. Meetings color-coded by ownership 
appear as follows:

Meetings owned (i.e. proposed) by you
Meetings that you have been invited to
Tentative Meetings owned (i.e. proposed) by you
Tentative Meetings that you have been invited to

Note: When you color code Meetings by ownership and open another user's Agenda, the Entries you (not
the Agenda's owner) propose will appear in blue—making it easier to spot Entries you can edit in other 
users' Agendas. (Even if you are in another user's Agenda, you can still edit an Entry you have 
proposed.). When working in someone else's Agenda as a Designate, Meetings proposed by the 
Agenda's owner will appear in blue, since you are working in that Agenda as though you were the owner.



Access Level
Controls who can access an Entry's information. There are four levels of access: Normal, Confidential, 
Personal, and Public.



Designate
Someone who has the right to modify the Entries of another user in that user's name. Designates can 
perform those operations specified by the Access Rights the other user has granted them. However, you 
can never set other users' (or your own) Access Rights while working as a Designate for someone else.

To grant someone Designate Rights, select Access Rights from the Options menu.



Tentative
Tentative Meetings are not yet official and final. To confirm a Tentative Meeting, deselect the Tentative 
checkbox on the General tab of the Edit Meeting window.



The Status Bar
The Status bar is displayed at the bottom of the window. To display or hide it, choose Status Bar from the 
View menu.

The left area of the Status bar describes actions of menu items as you use the arrow keys to navigate 
through menus. This area also displays messages that describe the actions of Toolbar buttons. To its 
right, the present date and time are given.

An icon in the middle of the Status bar notifies you when new Entries come in from other users. To its 
right, a bell icon is displayed when the Pop-up Reminder feature is turned on. On the far right-hand side, 
an icon indicates whether you are currently on-line or off-line.



The Toolbar
The Toolbar is displayed across the top of the application window, just below the menu bar. It provides 
quick mouse access to many tools used in your Agenda.

To hide or display the Toolbar, choose Toolbar from the View menu.



Node
A node is a database located on a server. There may be, and often are, several nodes on one server.

Nodes are identified by a number.



Remote User
A user whose Agenda is on a different server. They can be invited to Entries in the same way as local 
users.

However, a Remote user cannot act as a Designate.



Local User
A user on the same server.



Day Event

A Day Event is an Entry that is valid for an entire day. It does not block out any time in your Agenda's Day 
View. You can still schedule Meetings as usual when a Day Event has been scheduled. They can either 
be single or recurring events, and other users and Resources can be invited to Day Events. Day Events 
are displayed in the Notes View of your Agenda's Daily and Weekly pages and in the Month View.



Daily Note

A Daily Note is a memo you can enter into your Agenda. It does not have a time, only a date which it is 
displayed on. Daily Notes can be up to 64 characters long and are displayed in the Notes View of your 
Agenda's Daily and Weekly pages, as well as in the Month View. They can either be one-time or recurring
and can be sent to other users and Resources.



Task

You can enter Tasks in your Agenda. They can either be linked to a Meeting or be independent. A Task 
can be assigned a Start date and time, Due Date and time, a Priority and an Access Level.



Attachment

You can attach a file to a Meeting or Task using the Details tab of the New Meeting/Task or Edit 
Entry/Task dialog boxes. Attached files allow you to include necessary material with a Meeting or Task. 
Currently only one file may be attached to any given Meeting or Task.
You can only attach files while on-line.



Meeting

A Meeting is an Entry which takes up a scheduled amount of time. A Meeting may be an appointment, a 
course, etc.— anything that can be put into a time frame.
You can include a location, invite other users and Resources and make the Events recur. If you are not 
completely certain of all the details of your Meeting (time, location etc.), you can make it Tentative. If you 
delete a Meeting, or make any changes to it, the updates will automatically be made in invited users' 
Agendas.



Associate
To open an attached file, it must be associated with an application capable of reading it. If your system 
cannot find an application to open the file, it will ask you to associate the file with the appropriate 
application.



Reconciliation
Reconciliation is the process of making two versions of the Agenda consistent with one another, by 
reconciling the Entries that cause inconsistencies (i.e. you decide which version of the Entry you want to 
keep). You may need to go through this process when you upload your off-line Agenda to your on-line 
Agenda and when you import from or export to your palmtop.



Propose
An Entry is proposed by the person or Resource in whose name it was created. That is, you propose an 
Entry if you create it while working in your own name (i.e. not working as someone else's Designate). 
Entries created by a Designate working in your name are also considered to be proposed by you.

For color coding purposes, you own Meetings that you proposed. Meetings color coded by ownership will 
appear as follows:

Meetings owned (i.e. proposed) by you

Meetings that you have been invited to

Tentative Meetings owned (i.e. proposed) by you

Tentative Meetings that you have been invited to



The Status Bar Bell

This icon indicates that the Pop-up Reminder feature is turned on. It is displayed to the right on the Status
bar.



The Calendar

When you click the Calendar Button on the Date Control Bar, you can go straight to a specified date by 
clicking it on the Calendar that is called up.
When you click the Calendar Button next to a date box in a dialog box, you can set the date for that edit 
box by clicking it on the Calendar.
The arrows on the Calendar allow you to move forward and backward months and years at a time.

moves you back one year
moves you forward one year
moves you forward one month
moves you back one month

 always takes you back to the current date.
You can also use the drop-down list boxes at the top to choose the month and the year.



Help File Version 4.5



Search by Name
A few letters are normally enough to search by name. The letters you type must appear at the beginning 
of the name you are looking for.

On some systems, you may get the message "Surname string too short." In this case, more letters are 
needed to conduct a search.



Search by Number
When you use the Resource Number edit box to search for a Resource, the characters you type must 
appear at the start of the Resource number you are looking for.



Found List Box
Names matching the entered parameters appear in this list box.



Date Box

The Date Box will not allow you to enter a date that falls outside the designated time range allowed for the
type of Entry you are creating:
· For Meetings, Tasks, Daily Notes and Day Events, the date must fall between February 1, 1991 and 

November 30, 2037.
· For Address Book Entries, the date must fall between February 1, 1901 and November 30, 2037.

The Agenda will adjust the year in the Date box to the year within the allowed time range that most closely
matches what you have entered (for example, if you type 1977 in a Meeting Date box, the year will 
change to 2001, 2019, 1997 and 2007 as you type in each number).



Inviting Others
There are several ways to create or modify the list of invited users and Resources to Entries you 
proposed:

· Click  to search for people, groups or Resources.

· Click  to select a group for your list.
· To invite a user, type the name in the edit box.

To invite a Resource, type r:, re:, or res: followed by the Resource's name.
To invite a group, type g:, gr:, or grp: followed by the group's name.

· To delete a name, select it from the list box and click Remove.



Remote Resources
Resources located on a different server. The note in brackets will often indicate on what server or in what 
department the resource is located.



Priority
Allows you to set a level of importance or urgency for a Task. Tasks can be given a numeric or alphabetic 
value and can be sorted by this field.



Mail Notification
A message box may ask whether you want to send an e-mail notifying invited users of Entries you created
or modified. This will depend on your preferences (which can be set using Options menu, Agenda, 
Notification).

· To send an e-mail message, click Yes. The Mail Message dialog box will appear.
· Otherwise, click No. Your Entry will still appear in the invited users' In-trays and Agendas.



Conflicts
More than one Meeting has been scheduled to the same user or Resource at the same time. Double-click
a conflicting Entry for conflict details.

 indicates that a conflict exists.



Frequency Drop-Down List Box
The Frequency drop-down list box allows you to easily schedule Recurring Entries that repeat on a 
regular basis. There are five options in this list box:

· Select Daily to schedule the Entry every day or by a specific number of days.
· Select Weekly to schedule the Entry every week or by a specific number of weeks. You can also click

the days of the week you want the Entry to appear on. Click a day button again to deselect it.
· Select Monthly on Date(s) to schedule the Entries on specific dates of the month. Select the first box

to choose the same date in each month. For a different frequency, select the lower box and select the 
date(s) in the list box and type the frequency in the edit box. Use the Shift and Control keys to select 
more than one date.

· Select Monthly on Day(s) to schedule the days in each month the Entry will repeat Use the Shift and 
Control keys to select more than one day. Type the frequency of the repetition in the right-hand edit 
box.

· Select Yearly to schedule your Entry on a yearly basis. To choose multiple year intervals, select the 
second button and enter the desired number of years.



Task Sort Icon

Displays the column by which your Tasks are currently sorted.



The Send Button

Sends the Entry you are creating or modifying to the server.



The Resource Button

Allows you to add Resources to the Entry you are creating or editing.



The Dates Button

Displays and hides the list of dates for the current Entry at the bottom of the window.



The Delete Button

Lets you delete the Entry you are creating or editing.



The Attach Button

Lets you include an attachment with your Meeting.



Will Attend
Indicates you will attend this Meeting.



Will Not Attend
Indicates you will not attend this Meeting.



Will Confirm Later
Indicates you have not yet decided to attend this Meeting.



Send Mail
Sends a mail message to any and all users invited to this Entry.



Keep in Agenda
Indicates you will keep this Entry in your Agenda.



Remove from Agenda
Indicates you will not keep this Entry in your Agenda.



Decide Later
Indicates you have not yet decided to keep this Entry in your Agenda.



Completed
Marks this Task as being completed.



Not Completed
Marks this Task as not being completed.



AttendeesTab

This tab of an Entry window lets you add users and Resources to the current Entry.



Attachments Tab

This tab of an Entry window lets you attach a file to the current Entry.



Options Tab

This tab of an Entry window lets you add a reminder and set the Access and Importance levels, where 
applicable.



Main Toolbar
Displays and hides the Toolbar in your Entry windows.



Addressing Area
Displays and hides the Addressing Area in your Entry windows.



Date and Time
Displays and hides the General Information area in your Entry windows.



Dates List
Displays and hides the Dates List in your Entry windows.



Address
Brings the Address tab to the front of the Adressing Area.



Attachments
Brings the Attachments tab to the front of the Adressing Area.



Options
Brings the Options tab to the front of the Adressing Area.



Send
Sends the Entry you are creating, editing or viewing, with any changes you made.



Select Groups
Lets you add a Group to an Entry you are creating or editing.



Attach
Lets you add an Attachment to a Meeting you are creating or editing.



Delete Entry
Deletes the Entry you are creating or editing.



Find



Find Again




